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Overview of O ptivit y Telephon y Manager
Optivity Telephony Manager (OTM) provides a single point of access an

control for Nortel Networks Meridian™ system management.  OTM uses IP
technology to target the following key customer values: 

• single point of connectivity to the Meridian 1 and related devices

• single point of data collection for traffic and billing records

• single point of collection, processing, distribution, and notification fo
alarms and events

• single point of data entry and propagation (employee names and 
telephone numbers shared in multiple databases)

• Web-based management applications

OTM contains all of the Meridian Administration Tools (MAT) Microsoft® 

Windows® applications. In addition, OTM introduces new Web application
and integration with Optivity NMS.

OTM provides value by acting as a management server. It collects and 
processes alarms from multiple devices (Meridian 1, Call Pilot, ITG, etc.
collects call accounting and traffic data from multiple Meridian 1 systems

and acts as a terminal server for multiple devices. One OTM Windows N® 
Server replaces multiple buffer boxes, access modems, and terminal ser

OTM may be installed in a standalone configuration without client suppor
Web applications, to run on a PC running Windows 95/98 or Windows N
version 4.0. System access is provided through the OTM Windows Syst
Terminal, and security management through the OTM User Administrati
OTM Common Services User Guide
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Technical documentation
OTM technical documentation consists of an Installation and Engineerin
Guide and eight user guides. Table 1 outlines the contents of the variou
guides in the OTM documentation suite. The entries in the second and t
columns indicate whether the information in that section applies to:

• OTM Windows Navigator, which is the Microsoft Windows-based 
interface

• OTM Web Navigator, which is the Web (http) interface

• both interfaces  

Table 1
OTM 1.0 Technical Documentation Content (Part 1 of 6)

Book Title
Microsoft
Windows

Web Contents

Installation and 
Engineering Guide

X
X
X
X
X
X
X
X
X
X

Initial Installation Tasks:
OTM requirements

Installing a server
Installing a client

OTM server software installation
Serial numbers and keycodes
Java runtime environment (JRE)

OTM client software installation
Upgrades, migration, licensing
Installing Web help and documentation

(continued)
P0910103 Standard 1.0 July 2000
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Installation and 
Engineering Guide 

(continued)
X
X
X
X
X
X
X
X
X
X
X
X
X

(continued)
Initial configuration tasks:

Logging in, changing the default password
Testing the connection

Setting up OTM applications
Adding sites, systems, Windows users
Adding Web users
Setting up the Meridian 1
Setting up the Virtual Terminal Service
Setting up data buffering and access (DBA)
Setting up the LDAP server
Setting up alarm management
Performing an OTM backup
Installing a Web browser client

Windows NT installation example
Configuring a Windows NT server
Windows NT security guidelines
Modem configuration for OTM applications in 

Microsoft Windows
Integrating OTM with Optivity NMS
OTM engineering guidelines

Table 1
OTM 1.0 Technical Documentation Content (Part 2 of 6)

Book Title
Microsoft
Windows Web Contents
OTM Common Services User Guide
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Common Services 
User Guide

X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

X
X

X
X
X

X

X

X
X
X
X

Overview of Optivity Telephony Manager
OTM Windows Navigator
Configuring sites, systems, and users
Regular maintenance tasks
Services and utilities:

Scheduler
Import and export utilities
Corporate directory
Database compact/repair utility
Regional settings
Access server
Backup and restore
Directory services
Using LDAP synchronization
Electronic data dump
Event log viewer
System terminal
System monitor
Web services
OTM Web Navigator
Virtual terminal service
Desktop services (for administrators and end users) 

Data buffering and access (DBA)
Script file summary
Scheduling maintenance tasks 

Table 1
OTM 1.0 Technical Documentation Content (Part 3 of 6)

Book Title
Microsoft
Windows Web Contents
P0910103 Standard 1.0 July 2000
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Alarm 
Management 
User Guide

X
X
X
X
X
X
X
X
X
X
X
X
X

X
Alarm management configurations
Alarm browser
Meridian 1 alarm management

Alarm banner
Event monitor window

Alarm notification
Notification process
Setting up alarm notification
Events processing
Scripting
Script wizard and sample scripts

Working with control files
Files: devices, configuration, scripts

Maintenance 
Windows 
User Guide

X
X
X
X
X
X
X
X
X
X
X
X

X

X
X
X

X
X

Launching maintenance windows applications
OTM maintenance windows

Core CPU
I/O Ports 
Network Groups 
Network Loops 
PE Shelves 
PE Cards 
PE Units 
B- and D-channels 

Inventory reporting
Maintenance pages

Table 1
OTM 1.0 Technical Documentation Content (Part 4 of 6)

Book Title
Microsoft
Windows Web Contents
OTM Common Services User Guide
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Station 
Administration 
User Guide

X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

X

Getting started:
Retrieving and updating system data

Station administration:
Station data and synchronization considerations
Station administration windows and menus
Accessing station data
Adding and deleting stations
Swapping TNs
Managing station data
Designation strips (DNs)
Station data validation
Directory Service
Architecture, links, integration
Excess DN report
Station and directory synchronization
Desktop Services

Using station administration features:
Call Party Name Display (CPND)
Corporate directory
List manager
Voice mailbox
Global update

Communicating with a Meridian 1
Conversion utility
Reporting:

Generating reports
OTM file viewer
Designing report forms

Power user tool

Table 1
OTM 1.0 Technical Documentation Content (Part 5 of 6)

Book Title
Microsoft
Windows Web Contents
P0910103 Standard 1.0 July 2000
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ESN Analysis and 
Reporting Tool 
User Guide

X
X
X
X
X

Synchronizing the OTM ESN database and the 
Meridian 1
Updating the V&H table
Printing ESN reports
ESN Setup wizard

Telecom Billing 
System User Guide

X
X
X

Configuration
Operating procedures
User reference

Call Tracking 
User Guide

X
X
X

Collecting data from a Meridian 1
Call tracking menus
Sample setup for real time monitoring

Traffic Analysis 
User Guide

X
X

Configuration
User reference

Table 1
OTM 1.0 Technical Documentation Content (Part 6 of 6)

Book Title
Microsoft
Windows Web Contents
OTM Common Services User Guide
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Conventions used in this guide
This guide uses the following typographical conventions:

• User input—This font  alerts you to information that you enter on your
keyboard; or, using your mouse, this font indicates buttons to click o
menu selections to make.

• Multi-lettered keys—Angle brackets denote a single multi-lettered ke
on your keyboard. For example, <Esc>  denotes the Escape key, labele
Esc on PC keyboards.

• Key sequences—Keys that you press at the same time include at leas
multi-lettered key and are not separated by spaces in text. For exam
<Alt>V  instructs you to press the <Alt>  and V keys at the same time.

• Hot keys—You can access menu commands by using the mouse or 
keyboard. Menu items show one letter as underlined. To choose a m
item from the keyboard, hold down the <Alt>  key and press the 
underlined key. For example, press <Alt>F  to open the File  menu. 
P0910103 Standard 1.0 July 2000
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Overview of OTM applications
OTM 1.0 includes the following new or enhanced Windows-based 
applications:

• Enhanced Station Administration/CPND

• New Directory Service with LDAP support

• New Telecom Billing Service (TBS), which replaces MAT Call 
Accounting

• Data Buffering and Access (DBA)

OTM Windows-based applications can operate in either server or standa
mode on a PC running Windows NT version 4.0. It also can operate in cl
mode on a PC running Windows 95/98. For more information about 
configuring OTM in standalone mode, refer to “Standalone configuration”
page 42. For more information about configuring OTM in client mode, re
to OTM Installation and Engineering Guide (P0910102).

The following MAT 6.6 applications are supported in OTM:

• List Manager

• ESN

• Traffic Analysis module

• Call Tracking application

• Corporate Directory

• IP Telephony Gateway (ITG) applications

• Inventory

• Maintenance Windows

• Alarm Notification 
OTM Common Services User Guide
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OTM provides the following Web-based (http) applications.

• OTM Web Navigator

• Virtual Terminal Service

• Web System Terminal

• Web Station Administration (Desktop Services)

• Web Alarm Browser

• Maintenance Pages (provides a subset of Maintenance Windows 
functionality)

• Customizable Web Help

• Web User Access and Session Monitor pages

• Desktop Services that provides Web pages to display directory and 
telephone configuration

Comparison of OTM Windows and OTM Web interfaces
You can access OTM using either OTM Windows Navigator or OTM We
Navigator. You can perform many basic configuration and management t
through either interface. This section describes the similarities and 
differences between the OTM Windows Navigator and the OTM Web 
Navigator.

OTM Windows Navigator
OTM Windows Navigator gives you access to nearly all of OTM manage
systems. Through menus and folders you can:

• view, configure and administer sites, systems and users

• configure and administer OTM services

• launch utility applications

• display licensing and release information for all installed OTM 
applications
P0910103 Standard 1.0 July 2000
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The OTM Windows Navigator displays sites and systems in a tree struct
When you choose a system on the tree you can launch a System windo
configure the system and launch management applications. The OTM Sy
Navigator window displays all connected systems. When you select a sys
the list of available applications appears in the window. The OTM Windo
Navigator system access depends on the privileges assigned to your us
at the Meridian 1 site. For a list of available functions and applications, re
to Table 2 “Comparing Windows and Web Navigators”.

OTM Web Navigator
The OTM Web Navigator provides a number of the same functions availa
in the OTM Windows Navigator. The OTM Windows Navigator allows yo
to view, configure and administer sites, systems, and users. OTM Web 
security meets the same criteria as provided by Windows NT.

One of the advantages of the OTM Web interface is the ability for users 
configure their telephones through their Web browser. As an administra
using Web Desktop Services, you can also block end user access to 
configuration screens. A particularly useful Desktop Services feature is t
ability to customize the help files to suit specific customer needs.  

Table 2
Comparing Windows and Web Navigators

OTM Windows Navigator OTM Web Navigator

Common Services

Ability to launch other applications
Scheduler
Backup & Restore (OTM Data)
Import/Export
PC Event Log
Compact and Repair
License management
Related utilities

Data Buffering and Access
Event Service
System Sanity
Terminal Server
Trap Master
Trap Server
OTM Common Services User Guide
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Fault Management

PC Event Log and Viewer
Event Monitor
Alarm Banner
Alarm notification by:

• pager

• email

• file

• SNMP trap forwarder

Alarm Browser (consolidated systems)

• manage alarms from core PBX, 
Meridian Mail, ITG, SCCS and Call 
Pilot.

Configuration Management

Station Administration
Directory Editor
LDAP Query utility
LDAP Synchronization
Corporate Directory
Maintenance Windows

• real time status of hardware PBX

• sorting by type or status

• enable, disable, test

ESN
ITG Configuration
DBA Backup & Restore
List Manager
Inventory

Maintenance Pages
(sub-set of Maintenance Windows 
functions)
Customizable Web Help
LDAP Synchronization Report
Global Change
Desktop User Access
Web Navigator Access
Session Monitor

Table 2
Comparing Windows and Web Navigators (Continued)

OTM Windows Navigator OTM Web Navigator
P0910103 Standard 1.0 July 2000
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Accounting Management

Telecom Billing Services (TBS)

• analyzes CDR from multiple switches

• pre-defined reports

• customization of reports

Call Tracking

Performance Management

Traffic Analysis

Security Management

OTM User Template Administration Web Maintenance Pages
Web Navigator Access Security (Admin 
Login - Local Domain Security)
Web Desktop Access Security using WinNT 
security
Web Desktop Access Security using LDAP 
security

System Access

Windows System Terminal Web System Terminal

End User Applications

Windows Help Web help
End User Desktop Services

Table 2
Comparing Windows and Web Navigators (Continued)

OTM Windows Navigator OTM Web Navigator
OTM Common Services User Guide
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Common Services
The OTM Common Services are similar to the MAT Common Services. M
have been enhanced for OTM; several are new. The OTM Common serv
are:

• OTM Windows Navigator and OTM System windows

• OTM Windows based System Terminal

• New Import and Export Utilities

• New Compact and Repair Utility

• Enhanced 32-bit Scheduler

• Enhanced PC Event Log Viewer 

• Enhanced Database Access and Buffering  (DBA) and Station Fast S

• OTM user administration

• OTM Backup and Restore

• New System Monitor on the OTM server

• License management

• NT Client capability

OTM Server
The OTM server runs on a Windows NT Server or Workstation. It perfor
the following functions:

• Virtual Terminal Service provides single point of connectivity to th
Meridian 1 and related devices

• Common Services and file server for OTM client applications
• Database Access and Buffering (DBA) collects and stores CDR a

Traffic data
• Web Server for OTM Web-based applications
• Alarm and event collection, processing, distribution, and 

notification
• Run other management applications such as Call Pilot 
P0910103 Standard 1.0 July 2000
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Figure 1
OTM Server block diagram
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Configurations
Network model

OTM can manage voice switches in both a centralized and local manner

Centralized management is geared towards network management cente
whereas local management is geared toward site level telecom manage

Figure 2
OTM Network model

OTM at Network Center

IP
Network PSTN

OTM
Local access

Serial 
connections 

Remote access

Site 1 

System 1

System n

Site n 

System 1

System n
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Site model
Figure 1 shows an example of a single OTM as a Site Manager support
multiple voice devices in a single site. Client/Server acting applications (W
or Windows) can be run on the OTM server or remotely via IP or dial in 
connections.  

Figure 3
OTM Site model

One onsite OTM
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• Mercator PBX
• Other generic serial
OTM Common Services User Guide



Page 42 of 292  Overview of Optivity Telephony Manager

0 
te 

tion, 
 
to 
ith 
er 
g 
rs).

). 
ail 
Standalone configuration
OTM may be installed in a standalone configuration. The standalone 
configuration can run on a Windows 95, Windows 98 or Windows NT 4.
PC. An OTM system configured as a standalone does not allow for remo
clients or Web-based applications. System access is provided through 
Windows System Terminal, and Security Management is accomplished 
through OTM User Template Administration.

Common Services available in a standalone configuration include:

• Windows Navigator

• Scheduler

• Backup and Restore (OTM data)

• Import/Export

• Compact & Repair

In the area of fault management, when installed in a standalone configura
OTM provides a sub-set of the functionality available when installed in a
network.  The standalone configuration can be set up to forward alarms 
Optivity NMS. An enhanced PC Event Log and viewer is available along w
an Event Monitor which allows you to view Meridian 1 alarms. Alarm Bann
is included for core alarms, and Alarm Notification permits handling, filterin
and forwarding (including forwarding to numeric and alphanumeric page

Call accounting is accomplished using the Telecom Billing System (TBS
Data Buffering and Access (DBA) provides real time collection of Call Det
Recording (CDR) and Traffic data via IP. Data collected by DBA or via 
buffer box can be used by Traffic and TBS to generate reports.
P0910103 Standard 1.0 July 2000
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The standalone configuration supports the following configuration 
management and maintenance activities:

• System Window

• Station Administration

• Directory Editor (including Employee Editor and others)

• Directory Service with integration with Station Administration

• Lightweight Directory Access Protocol (LDAP) query utility

• Corporate Directory (export station data, MAT functionality)

• Maintenance Windows

• Electronic Switched Network (ESN)

• Internet Telephony Gateway (ITG) configuration

• DBA Backup and Restore (X11 database)

• List Manager

• Inventory

Connectivity through OTM
The Virtual Terminal Service provides the connection between your brow
and a device or system. You can launch the OTM Web Navigator from a W
browser such as Internet Explorer or Netscape Navigator, and select a 
Meridian 1 system or other device to view. 

You can access those systems and devices using OTM’s Web System 
Terminal window from within your Web browser, without referring to IP 
addresses, serial port settings, or URLs. That information is retained on 
OTM server. 

If you are not using Access Server, uncheck the “Launch Automatically” 
check box. This allows the server COM port to be used by another 
application, if needed.  

CAUTION
For security reasons it is recommended strongly that you configure RAS to allow the 
incoming call to Access the Computer Only. This setting allows access to the RAS serve
but not to the rest of your network. 
OTM Common Services User Guide
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Figure 4 shows the various ways you can use OTM to connect to networ
devices and systems, such as the Meridian 1. The figure legend, which 
follows the figure, describes these connections in more detail. 

Figure 4
OTM Connectivity
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Figure 4 Legend

1 OTM users can access a system via the OTM Windows and Web Navigators. Applications include Syste
Terminal as well as any Web-based applications supported by the system. OTM clients on the CLAN/ELAN c
also use the OTM Windows based applications (Station Administration, ESN, etc.).

2 OTM provides the connectivity to the M1 for all windows and Web-based applications.

3 Generic IP System connection - the Web-based System Terminal provides a telnet type connection to an
connected system or device. You can also navigate to the device’s management Web pages (if applicable).
Example: MIRAN II cards provide both a telnet access and Web-based management applications.

4 Com Ports - the OTM server can be equipped with a Multiple Serial card to provide up to 8 additional co
ports. These ports can be used for dial in or dial out.

5 Generic System direct serial connection - allows direct connection to any serial device. For example, for
legacy Meridian 1 systems (R21 and earlier), you can connect to a maintenance TTY port and capture the 
error messages. A new OTM Text Handler capability can filter the TTY output and generate SNMP traps fo
selected error messages.

6 Generic System remote serial connection - when connecting to a remote serial system you select the co
port and manually dial the number of the desired system.

7 Access Server - provides a serial command line interface (CLI) into the OTM Server, enabling remote 
access. Once connected, you can change Windows NT passwords or connect to any system or devices de
and enabled in the Virtual Terminal Service. The CLI is launched at Server Startup, and opens a status wind
displaying different status messages. The CLI Configuration window allows you to configure the server COM
port settings. A real-time Log file details all CLI activities. For more details, please see “Access Server” on 
page 119.

8 Remote Access - You can dial in to the OTM Server, log in using the Windows NT Remote Access Servi
(RAS) and access all defined systems, such as Web System Terminal or system specific Web applications.
addition, you can use the PC Anywhere application to dial into an OTM client PC on the CLAN/ELAN.

9 Web Alarm Browser - displays alarms collected from multiple supported Meridian 1 systems and device

10 PC LAN cards - provide access to both the CLAN and ELAN. 
OTM Common Services User Guide
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Alarm Management
OTM Alarm Management provides an alarm collection and processing ce
for multiple systems and devices. OTM receives SNMP traps from syste
such as the Meridian 1 and Call Pilot, and stores them in a circular log file
the OTM Server. The OTM Alarm Notification application monitors the 
incoming traps and notifies the appropriate people of important events a
alarms.

OTM Alarm Management has the following components:

• A Web-based Alarm Browser - used for viewing alarms from multiple
systems and devices. HTML help is provided for individual alarms.

• A Windows based Alarm Browser - used for viewing Meridian 1 speci
alarms. Windows help is provided for individual alarms.

• An Alarm Notification application - provides a scripting language to 
generate notifications on selected incoming traps. Notification types
include pagers, email, and the forwarding of SNMP traps to an upstre
processor (such as Optivity NMS). Notification is triggered by trap da
such as alarm severity, device type, and time of day. A Script Wizar
application simplifies the creation of Alarm Notification scripts.

• Text Handler application - parses maintenance TTY output and gener
traps on selected error messages. This is intended primarily for lega
Meridian 1 systems (Release 21 and earlier) and Meridian Mail syste
which cannot generate traps. Text Handler rules can be created by 
user to support other serial devices.

• PC Event Log and Viewer for viewing events and alarms generated 
the OTM Server and all of its Windows clients. This Windows 
application can also generate SNMP traps based on the event seve
level. 
P0910103 Standard 1.0 July 2000
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Figure 5 shows the main components of OTM Alarm Management. The T
Master is responsible for handling the SNMP Traps from the systems an
storing it on the server for retrieval by the Alarm Browser client. The Tra
Server distribute traps to applications registered to receive traps such as
Alarm Notification.

The Trap Master and Trap Server are run as a Windows NT Services on
OTM Server. 

OTM integrates with Optivity Campus 9.0.1 and Optivity NMS 9.0.1. The
devices represented in Optivity are OTM servers that are managing indivi
Meridian voice elements. These are manually added by the Optivity 
administrator. See Figure 6.

Figure 5
OTM Alarm Management block diagram
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For a list of supported devices and additional information on alarm 
management, see the Optivity Telephony Manager Alarm Management Use
Guide.

Access Server option
The Access Server capability is available as an orderable option within a
OTM server.  This functionality allows CLI access to an OTM Server usi
either a serial port directly or a modem.  From the OTM Server connectiv
is available to configured devices using the connection capability within 
Virtual Terminal Server functionality.  This connectivity must be 
pre-configured within Virtual Terminal Server to be available to a CLI 
connection.  

Figure 6
Centralized Alarms
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Typically this would be installed on an on-site PC that is used like a term
server to allow a single connection to the site and then to fan out this 
connectivity to multiple devices that are connected to the OTM Server.  
Access from the remote location can be either via a human interactive ses
(via a terminal session), or by a remote machine communicating via scri

OTM Access Server is an option that can be used with any level of OTM
package (General, Enhanced, or Premium).  This CLI input capability is 
added by ordering the “Access Server” to add to the OTM server. In fact
Access Server is ordered, it is not necessary to order any Set Expansion
Packages, if all that is required is to use the Access server mode.  Of co
if OTM management functionality, such as Station Administration, is 
required, then it will be necessary to order the Set Expansion Packages
OTM Common Services User Guide
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OTM Windows Navigator
OTM Windows Navigator and OTM Web Navigator are the two main 
graphical user interfaces (GUIs) to OTM. These two GUIs provide acces
most of the OTM systems and services. 

OTM Windows Navigator, which uses the Microsoft Windows interface, 
shows the names and types of all systems available to the current user,
allows you to group the systems into sites for more convenient access. 
example of the OTM Windows Navigator is shown in Figure 7.  

Figure 7
OTM Windows Navigator window
OTM Common Services User Guide
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OTM Web Navigator, which uses the Web (http) interface, provides acce
to OTM’s Web-based features and services. For more information about
OTM Web Navigator and the features and services to which it provides 
access, see “OTM Web Navigator” on page 210.

OTM Windows Navigator provides the following functions:

• Displays a “tree” structure for Sites and Systems on the network 
managed by the current user. Access systems at a site by opening t
site.

• Allows you to launch the System Window.

• Allows you to configure and administer OTM data: Sites and System
Users.

• Allows you to configure and administer OTM Services, such as 
Integrated Telephony Gateway.

• Allows you to launch utility applications such as the Scheduler, 
Corporate Directory, and Alarm Notification.

• Allows you to display the licensing and release information for all 
installed OTM applications.

• Allows you to print reports.
P0910103 Standard 1.0 July 2000
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Figure 8 illustrates these functions.      

Figure 8
OTM Windows Navigator functions
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Using OTM Windows Navigator 
OTM Windows Navigator allows you to access any Meridian 1 system o
other systems that your user ID privileges allow you to. In OTM Navigato
you open the site of interest to choose a system on which to work. 
Double-click a system to open its System window and launch any of the O
applications to work on that system. 

Open a site by double-clicking its name or clicking the “+” symbol next to t
site. The “+” changes to a “-” when the site opens. An open site displays
systems at that site. Close a site by clicking the “-” symbol.

For Meridian 1 systems, the components that make up the system appe
the system window. OTM displays a terminal emulation window for syste
defined as “Other.”

For information about using the OTM Web Navigator, see “OTM Web 
Navigator” on page 210.

Logging in and launching OTM Windows Navigator
In the Start menu, under Programs, select OTM. The login dialog appears. as
shown in Figure 9. Enter your User ID and password. The OTM Window
Navigator window appears, as shown in Figure 10.  

Figure 9
Login dialog box
P0910103 Standard 1.0 July 2000
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OTM Navigator menus
Detailed descriptions of the functions of each command in the Navigator
menus are available by clicking the context-sensitive Help button in the 
toolbar.  

Figure 10
OTM Navigator window
OTM Common Services User Guide
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Services Folder
The services folder contains applications and services available for sites
systems defined and accessible by the OTM PC. 

IP Telephony Gateway Applications
The following OTM applications provide configuration and maintenance f
the ITG card.

• ITG M1 IP Trunks
This application configures and maintains the 8-port ITG (trunk) card
that resides in the IPE shelf of a Meridian (M1) system. The card ha
10/100 baseT connection to carry pocket-sized voice and fax calls o
IP data networks, and can serve as a toll bypass to the traditional PS
For more information refer to Meridian Internet Telephony Gateway 
(ITG) Trunk 1.0/Basic Per-Trunk Signaling (553-3001-116).

• ITG ISDN IP Trunks
This application configures and maintains the 24-port ITG (trunk) ca
that resides in the IPE shelf of the Meridian 1 (M1). The card appear
the switch as a 24-port  trunk card with ISDN Signaling Link (ISL) an
D-channel signaling. The card has a 10/100 baseT connection to ca
packetized voice and fax calls over IP data networks. For more 
information refer to Meridian Internet Telephony Gateway (ITG) Trunk
2.0/ISDN Signaling Link (ISL) (553-3001-202).

• ITG M1 IP Lines
This application provides the configuration and maintenance of the I
line card for IP Telecommuter. This application configures the IP Lin
gateway and the gatekeeper, but not the H.323 IP terminal or PC-ba
software client. For more information refer to Meridian Internet 
Telephony Gateway (ITG) Line 1.0/IP Telecommuter (553-3001-119).

• ITG IP Phones 
This application provides the configuration and maintenance of the I
gateway card for the Meridian Internet Telephone, also referred to as
i2004 set. The i2004 set is a true Internet telephone when connected
Meridian 1 through an IPE-to-ITG gateway card. The configuration o
i2004 is through the Station Admin application in OTM. For more 
information refer to Meridian Internet Telephony Gateway (ITG) Line 
2.0/i2004 Internet Telephone (553-3001-204).
P0910103 Standard 1.0 July 2000
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Toolbar
The OTM Navigator toolbar includes several buttons that act as shortcut
the commands available in the menus. The function of each button in th
toolbar appears when you move the mouse over the button. See Figure

Status Bar
A Status Bar is located at the bottom of the window. To display or hide t
Status Bar, use the Status Bar  command in the View menu. 

The Status Bar describes actions of the menu commands as you use the m
to navigate through menus. It also describes the actions of the Toolbar bu
as you press them. When you choose a menu command, the Status Bar
describes the progress of the command while it executes. For example,
Status Bar shows Printing text  when you choose Print  from the File menu.

Figure 11
Navigator Toolbar
OTM Common Services User Guide
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Working with the OTM System Window
From OTM Navigator, double-click the system on which you wish to wor
and the System window for that system appears. See Figure 12.  

Figure 12
System window
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OTM System window allows you to launch the following applications (som
of these applications are purchased separately):

• Alarm Banner 

• Events

• System Terminal (Ethernet or PPP)

• System Terminal VT220 (serial)

• Station Administration

• Traffic Analysis

• Telecom Billing System

• Call Tracking

• ESN Analysis and Reporting Tool

• Maintenance Windows

• Inventory

• LDAP Synchronization

OTM System Window menus
Detailed descriptions about the functions of each command in the OTM 
System window menus are available by clicking the “Context-sensitive He
button in the toolbar.
OTM Common Services User Guide
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Configuring Sites, Systems, and
User accounts

This chapter provides instructions for changing the default login passwo
and defining your own OTM sites, systems, and user accounts. Only OT
administrators have authorization to perform these tasks. 

Changing the default login password
The default login password (Admin ) should be changed immediately after 
OTM is installed to ensure security. Follow these steps if you have not 
changed the password.

1 If OTM is not already running, follow these steps to start OTM and login 
using the default login password:

• Choose OTM Navigator from the Programs list in the Start  
menu.

The OTM login dialog box appears. 

• Enter the default system administrator user ID and password. 
For security purposes, the password does not appear as you 
type it in the Password field.

User ID: Admin

Password: Admin

• Click OK.

CAUTION
To ensure security, you must change the default password. Follow the 
steps in this procedure to select a new password.
OTM Common Services User Guide
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After OTM accepts your ID and password, the OTM Navigator window 
opens. 

2 In the Navigator window, choose Change Password  from the 
Security  menu to open the Change Password dialog box.  

3 Enter the old password in the Old Password field.

4 Type a new password in the New Password field.

5 Retype the new password in the Confirm Password field.

6 Click OK. 

7 A message box informs you that the password was successfully 
changed. Click OK .

OTM will require the new password the next time you log on.

Site and system administration
The system administrator defines the sites and systems that appear in t
Navigator window. Sites and systems must be defined before users can
connect to a system and perform maintenance tasks. A site typically 
represents a physical location containing one or more systems. Systems
defined as Meridian 1 or Other (non-Meridian 1). Other provides access
through VT220 Terminal Emulation such as Meridian Mail. Additional 
system types such as Meridian Passport and MSL-100 are examples of 
additional systems that can be added (refer to the appropriate user guide
more information). The Navigator Configuration menu allows the system 
administrator to add, change, and delete sites and systems.

Figure 13
Change Password dialog
P0910103 Standard 1.0 July 2000



 Configuring Sites, Systems, and User accounts Page 63 of 292

s, 
Note: For more information about the Navigator and System window
see “OTM Windows Navigator” on page 51.

Adding a site
You can add any number of sites to the Navigator window. 

1 In the Navigator window, choose Add Site  from the Configuration  
menu. The Site Properties window appears (Figure 14).

2 Fill in the Site Name and Short Name fields (these are required fields).

The Site Name  appears in the Navigator tree. The Short Name is an 
abbreviated site name that displays in the Alarm Banner.

3 In the Site Location box, fill in the site address information.

4 In the Contact Information box, fill in the contact name and related 
information. Click Apply .

5 To add a new system to this site:

Figure 14
New Site Properties sheet
OTM Common Services User Guide
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— Click Add System . 

— Follow the instructions for “Adding a system” on page 64.

6 When you have finished entering Site information, click one of the 
following buttons to add the site to the Navigator tree:

— OK  adds the site and closes the property sheet

— Apply  adds the site and leaves the property sheet open allowing 
you to add another system to this site (you may repeat step 5 to 
add another system)

— Cancel  closes the dialog box without adding the site.

Adding a system
You can add as many systems (including non-Meridian 1 systems) to a si
your license permits. You must have administrator privileges to add a sys

1 In the Navigator window, select the desired site.

Note: If you are adding a new system from within the New Site 
Properties window, skip to step 3 in this procedure.

2 Choose Add System  from the Configuration  menu or the right mouse 
button pop-up menu.

3 In the Add System dialog box, select the type of system you want to 
add. Then click OK.

Note: You may need to install additional software to enable other 
system types not listed here. Follow the installation instructions 
included with your order.

Figure 15
Add System dialog box
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4 Click the System Properties— General  tab  (Figure 16) enter the 
System Name and Short Name (required fields) and other information 
as needed. Click Apply .

You can make system location and contact information the same as 
site information by clicking the Same as Site checkbox.

Note: Bolded fields indicate required information. To change a value, 
edit the field. Some fields may have a list of predefined choices. An 
arrow within a field indicates a drop-down list of choices. Press the 
arrow to select from the list. For more detailed information, refer to the 
online help.

Figure 16
System Properties—General tab
OTM Common Services User Guide
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5 To add a new communications profile click the System 
Properties— Communications  tab. This tab defines the types of 
communications profiles that may be applied to system applications 
(one profile may be used for multiple applications).

Click Add . The Add Communications Profile dialog box appears. See 
Figure 17.  

Figure 17
Add Communications Profile dialog box
P0910103 Standard 1.0 July 2000
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Select a communications type from the Type box and enter a Profile 
Name, then click OK to go back to the Communications tab. See 
Figure 18.

Fill in the communications information for the new profile:

For Ethernet:  Select the appropriate network protocol. Enter the IP 
address that you configured on the Meridian 1. Click Apply .

Figure 18
System Properties—Communications tab—Ethernet Profile
OTM Common Services User Guide
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For PPP:  Enter all modem parameters and dialup information. Select 
PPP in the Modem Script text box. Set the IP address to the local IP 
address, as configured on the Meridian 1. Click Apply .

Figure 19
System Properties—Communications tab—PPP Profile
P0910103 Standard 1.0 July 2000
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For Serial:  Enter all modem parameters and dialup information. Select 
the appropriate value in the Modem Script drop-down box. This will 
usually be “None” unless a specific value is defined for your system. 
Click Apply .

Figure 20
System Properties—Communications tab—Serial Profile
OTM Common Services User Guide
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6 Click the System Properties— System Data  tab (Figure 21). Enter 
the machine/system type and release version for the system and 
enable or disable M1 packages. For example, if your machine type is 
the Option 61C, enter 61C in the Machine field and enter 1 in the 
Release field.

Note: You can copy this data directly from an installed switch by 
scheduling an upload with the File  menu Update System Data  
command in the System window. Update System Data uses the 
communication profile for Station Administration. However, you should 
configure the Release number here first to allow available applications 
to show up properly in the Applications Tab.

Figure 21
System Properties—System Data tab
P0910103 Standard 1.0 July 2000
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7 Click the System Properties—  Applications  tab (Figure 22). 

This tab defines the OTM applications that will appear in the System 
window and the communications profile to be used with each 
application. You must enable an application for it to be available in the 
System window.

To enable an application:

• Select the application in the Applications box.

• Select a Communications Profile from the drop-down list in the 
Selected Application box.

A checkmark appears next to the application and the Enabled box is 
also checked.

To disable an application:

• Select the application in the Applications box.

• In the Selected Application box, click the Enabled checkbox to 
remove the checkmark.

Figure 22
System Properties—Applications tab
OTM Common Services User Guide
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8 Click the System Properties— Customers  tab (Figure 23).

This tab lists the customers currently defined for this Meridian 1 
system. You may add new customers, delete customers, or review the 
properties of a selected customer. When you add a new customer, you 
configure the Meridian 1 features and numbering plans that are 
available to the customer. This information is not automatically 
updated on the Meridian 1 and must be updated by using the LD15 
customer overlay, the overlay interface which allows customers to 
configure their systems on the M1 switch. For more information on 
overlay interfaces, see the System online Help.

Note: Customer information is required for System 
Administration/CPND and ESN applications. 

Figure 23
System Properties—Customers tab
P0910103 Standard 1.0 July 2000
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9 To add a customer:

— Click Add  in the System Properties—Customers  tab.

— Select a Customer number. Click OK.

— Select the General  tab, in the Customer Property sheet 
(Figure 24) and fill in the customer information.

Note: Enter User information in the Scheduler System ID text box if 
you are using applications with scheduled activities, such as Station 
Administration/CPND, ESN, Traffic, and Call Accounting. 

Figure 24
Customer property sheet, General tab
OTM Common Services User Guide
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• Select the Features  tab (Figure 25), and fill in the customer 
information.

Figure 25
Customer property sheet, Features tab
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• Select the Numbering Plans  tab (Figure 26), and fill in the 
customer information. 

10 When you have finished entering customer information, click one of the 
following buttons to save the information:

— OK  to add the customer and return to the System properties 
sheet.

— Apply  to add the customer and leave the Customer properties 
open so that you may add other information for this customer.

— Cancel  closes the dialog box without adding the customer.

11 To delete a customer, click Delete  in the System 
Properties—Customers  tab. A delete confirmation box opens. Click 
OK .

12 To modify customer information, click Properties  in the System 
Properties—Customers  tab. The Customer property sheet opens. 
Modify information in the appropriate tabs and click OK.

Figure 26
Customer property sheet, Numbering Plans tab
OTM Common Services User Guide
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13 In the System properties sheet, click one of the following buttons:

— Apply  adds the system and leaves the dialog box open.

— OK  adds the system and closes the dialog box.

— Cancel  closes the dialog box without adding the system.

— Help provides online help.

The new system is added to the tree under the selected site.

Changing site information
You can change any information about a site, including the site name, 
address, and contact. You must have administrator privileges to change
information.

1 In the Navigator window, select the desired site.

2 Choose Properties  from the File  menu or the right mouse button 
pop-up menu. The Site Properties dialog box opens to the General  
tab.

3 Bolded fields indicate required information. To change a value, edit the 
field. Consult the online help for details on any field.

4 To add a new system to this site, click Add System , and fill in 
information for the new system. See “Adding a system” on page 64.

5 Click one of the following buttons:

— Apply  saves the information and leaves the dialog box open.

— OK  saves the information and closes the dialog box.

— Cancel  closes the dialog box without saving.

— Help provides online help.
P0910103 Standard 1.0 July 2000
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Changing system information
You can change any information about a system or its communications 
connection. You must have Administrator privileges to change any syste
information.

1 In the Navigator window, select the desired system.

2 Choose Properties  from the File  menu or the right mouse button 
pop-up menu. 

The System Properties window opens. 

3 Select the tab containing the information you wish to change. 

Bolded fields indicate required information. To change a value, edit the 
field or select a different item from a field popup menu. An arrow within 
a field indicates a drop-down list of choices. Press the arrow to select 
from the list. Consult the online help for details on any field.

4 Click one of the following buttons:

— Apply  saves the information and leaves the dialog box open.

— OK  saves the information and closes the dialog box.

— Cancel  closes the dialog box without saving.

— Help provides online help.

Deleting a site or system
You must have administrator privileges to delete a site or system from th
Navigator window. A record of the deletion is stored in the PC event file.

WARNING: Deleting a site also deletes all of its systems.

1 In the Navigator window, select the site or system.

To delete all sites and systems, select the Sites icon at the top of the 
tree.

2 Choose Delete  from the Edit menu.

3 Click OK to confirm.

Changing your password
You can change your password at any time. If your password has expire
OTM prompts you to enter a new password when you attempt to log on. R
to “Changing the default login password” on page 61.
OTM Common Services User Guide
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Configuring OTM Windows users
OTM allows you to create User Templates to speed the process of addin
users accessing the OTM Windows Navigator. A template is a form that 
fill in to define most aspects of a certain kind of user, such as their level 
access to sites and systems and automatic connection to particular syst
You can create as many user templates as you need. You will assign a 
template to individual users when you add users to the OTM database.

Note: Access to the OTM Web Services is provided through Window
NT. Refer to See “OTM Web Services” on page 209.

Creating a user template

1 In the Navigator window, choose OTM Users  from the Security  menu 
to display the OTM Users window (Figure 27).

Figure 27
OTM Users window
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2 Choose User  Templates  from the Configuration  menu. The User 
Templates window appears (Figure 28).

3 Choose Add Template  from the Configuration  menu. The New 
Template property sheet appears (Figure 29). 

Figure 28
User Templates window

Figure 29
New Template property sheet
OTM Common Services User Guide
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4 Enter a name for this class of user. 

For each site, system, and application in the tree, use the right mouse 
button to assign user privileges (Read-write, Read-only, or No 
Access). Each click of the left mouse button causes the access 
privileges and corresponding icon to change. See Figure 30. Select 
the Administrator box, if appropriate. The site and system icons 
change to reflect the access level.

Note: Access privileges defined for sites or systems at higher levels 
in the tree structure are applied to all subordinate items.

5 Enter values in the User ID and Password text boxes to allow this class 
of user to connect to this system without having to enter a User ID and 
Password each time you want to connect.

6 Click OK. Close the User Template window.

Figure 30
Access privilege icons

Read and write access

Read only access

No access
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Adding a user

1 In the OTM Users window, choose Add User  from the Configuration  
menu.

The New User property sheet appears (Figure 31).

2 Enter a User ID, and from the Access Template drop-down list, select 
the template that you will use as the basis for this user definition.

3 Fill in other data as required. The window prompts you to enter a 
password and confirm it after clicking OK or Apply . 

4 Click the Change Password  button to change the OTM login 
password for this user only.

5 Click OK. The new user appears in the OTM User window. Close the 
OTM User window.

Figure 31
New User property sheet
OTM Common Services User Guide
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Deleting a user template
A user template can only be deleted when all associated users of that tem
are either deleted or re-assigned to another template.

Restricting user access permission levels
A user can be restricted from having access to sites, systems and applica
However, when a user is defined as being restricted from any access to
sites, systems and applications, i.e., the Navigator, the user will, in fact, 
able to see all the sites and systems in the Navigator tree and have read
access to their properties. If a restricted user tries to open a system they
see a System Window with no applications visible.

Sites and systems displayed in user templates
When adding or modifying a user template, only systems that have 
applications enabled are presented. If no applications are enabled for th
systems within a given site, the site and system(s) will not appear in the
Template Properties.
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Maintenance Tasks
The following guidelines and tables indicate suggested scheduling of var
OTM operating procedures.

Telecom Billing System
Please refer to “Chapter 3: Operating Procedures” of the Telecom Billing 
System User’s Guide for complete details of the schedules for data collectio
database maintenance, and data management. The database maintena
schedules outlined in this chapter should also be used for OTM Corpora
Directories.

Call Tracking

Table 3: 
Call Tracking Maintenance Tasks

Maintenance Task Schedule

Data collection (real time) Continuously

Data collection (from a file) Hourly

Review Alarm Log No set schedule. review as 
needed

Backup and archive Call Tracking 
database

The main Call Tracking 
database is part of the 
site/system data files. This 
will be backed up/archived 
with the other databases.

Restore Call Tracking database As necessary
OTM Common Services User Guide
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Traffic Analysis

OTM Site/System Data

Table 4: Traffic Analysis Maintenance Tasks

Maintenance Task Schedule

Data collection (through direct connection 
to Meridian 1)

Hourly

Data collection (through buffer or DBA) Daily

Backup/Archive Traffic database Archive the Traffic database 
monthly. Remember to 
purge old or unneeded data 
from the working directory 
during this Archive 
procedure

Restore Traffic database As necessary

Table 5: OTM Site/ System Data Maintenance Tasks

Maintenance Task Schedule

Backup Employee database Weekly

Backup all other databases (OTM 
Corporate Directories) for site/system:

Monthly

Restore databases for site/system As needed

Note: Since the Employee database is usually edited more frequently, you should 
back up the database on a weekly basis instead of on a monthly basis (as you 
would with the other OTM databases).
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Compact and Repair Utility
The Compact and Repair Utility is usually not run on a set schedule. Thi
utility is used to help repair and compact MS Access database files in O
that may be corrupted or have taken too much disk space. You should 
therefore run this utility at any time you have deleted or purged a large 
number of records from one of the system databases. For example, if yo
deleted a large number of call records from the Call Database, or if you m
major edits to the Employee Database (especially deletions), then you sh
run the Compact and Repair utility databases. This will optimize your dis
space an repair any possible flaws in these MS Access database files.
OTM Common Services User Guide
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Scheduler
This chapter contains a general overview of the Scheduler. For more 
information about how to use the Scheduler windows, refer to the Sched
online Help.

The Scheduler schedules an Optivity Telephony Manager activity (or an
Windows application) for processing at a later date and time. With Schedu
you can define the intervals you want to run the activity. If there are multi
tasks in a job, you can assign the tasks in a sequential order using the q
function.

The Scheduler normally runs in background mode. This means that if an
OTM application is due to run at a certain time, the Scheduler automatic
runs it at that time without interrupting current sessions.

Note: The Scheduler must be running in the Windows environment 
the time an event is to run. You can start the Scheduler application a
time. An event and its tasks do not execute if the Scheduler is not run
at the scheduled time.

Access the Scheduler
There are two ways to access the Scheduler:

• From the OTM Navigator click Scheduler on the Utilities menu and 
schedule the activity directly.

• From any supported application select the Schedule command whe
appears in that application. For example, you can click Schedule  in the 
Reporting dialog of the Telecom Billing System. You can use the 
Scheduler functions to enter the information to schedule this 
application.
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Jobs and tasks
The Scheduler represents scheduled activities (such as, data collection,
synchronization and reporting) as jobs and tasks.

What is a job?
A job contains the scheduling properties of an activity. This includes suc
information as the activity’s: initial execution time; interval for additional 
executions; status; name; and queue assignments. The job also contain
actual task that identifies the activity’s actions. That is, each task that runs
actual activity will be assigned to a job. This way, the task can be schedu
Only jobs can be scheduled; individual tasks cannot be scheduled witho
job.

What is a task?
A task contains the actual command used to invoke the activity from the O
application. This includes such information as the activity’s: command lin
(the code used to invoke the activity); its priority in the list of tasks (when
should be executed in relation to any other tasks in the list); and any 
dependencies associated with it (physical resources on your PC that are
needed to execute the activity).

In most cases, one job will have one task. This simplifies the process of 
defining and scheduling activities. You would simply schedule the activit
assign it as a task to a job, and then enter its scheduling criteria. There a
instances, however, when it would be beneficial to assign multiple tasks 
single job (e.g., in situations where you wish to run multiple tasks all at t
same scheduled time). The Scheduler allows you to assign multiple task
each job after they have been defined.

About the Scheduler window
The following sections describe the Scheduler window and the menus of
Scheduler.
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The main Scheduler window contains sections which list the scheduled 
and queues. These sections provide the interfaces for the Job, Queue, a
Dependency Queue Managers and list the running tasks for each job. U
these sections to view and access your jobs and queues.

The main Scheduler window contains the following information sections

Scheduled jobs section
The Job Manager displays the details of all of the scheduled jobs in the 
left section of the window. The display shows the job name, scheduled d
and time for initial execution, intervals, and number of tasks in the job.

Job in the queue section
The Queue Manager displays the current status of jobs in the queue in t
bottom left section of the window. When the last task of a job completes,
queue record disappears.

Figure 32
Scheduler window
OTM Common Services User Guide
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Dependenc y resource section
The top right section of the window displays the current status of the 
dependency queues whose tasks are executing. The Dependency Queu
Manager displays the information. A dependency queue is a collection o
tasks requiring the same system resource (e.g., two tasks need to acces
COM port at the same time).

The following describes the properties of a dependency queue’s tasks.

• Each task in the dependency queue is a top task of some queue.

• The order of tasks in the task list of a dependency queue defines the o
of task execution.

• You can move tasks in the list up or down or edit tasks, except a task
has started processing.

• When a task completes, its record disappears from the task list.

• Tasks requiring more than one system resource appear in more than
dependency queue. If you delete a task record from one dependen
queue, the task record is automatically deleted from other depende
queues.

Tasks runnin g section
The bottom right section shows the tasks that are running now. From here, 
you can delete any running tasks. When deleted, a task is no longer monit
by the Scheduler. If you delete a task, the application containing that tas
continues to run.

File Menu
From the File menu commands you can manage the Scheduler jobs and
queues and exit from the Scheduler. Use the Help command to get deta
descriptions about the functions of each command.

Edit Menu
The Edit menu allows you to manage defined jobs or queues. Use its 
commands to enable or disable the defined jobs or queues. Use the Hel
command to get detailed descriptions about the functions of each comm
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View Menu
The View menu allows you to:

• display or hide the Scheduler’s toolbar and status bar

• view the task list of the highlighted job or queue

• arrange the jobs or queues within each section of the window
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Import and Ex port Utilities
This chapter contains a general overview of the Import and Export utilities
describes their basic function and purpose.

The Import and Export utilities are used to import and export data to and f
the Optivity Telephony Manager (OTM) data base files. These tools allo
you to share data between the OTM data bases and other applications.

Examples of situations in which you would find the Import and Export 
utilities useful are:

• If you are installing a new Meridian 1 system, and already have a sou
that contains user data (i.e., Names, Departments, Managers), you 
import these fields into the OTM Directory. You can then use Station
Administration to assign telephones to the imported user records.

• Synchronizing with an LDAP database to complete the unique identi
(UID) fields.

• The OTM Directory can be exported for external telephone book 
generation or for importing into other external data bases.

Import utility
The Import utility is used to import data records from an external source 
specific site/system and convert them to a format compatible with the O
data bases. This function is useful for quickly updating your data bases 
data from another application.
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When importing data, you can select from a predefined import configurat
or you can define your own configuration. The following sections will outlin
how to import data using a predefined and custom configuration. Review
sections later in this chapter for details on the functions and dialogs used
perform these steps.

Import data using a predefined configuration
To import data using a predefined configuration, you must first select the
configuration and its component values. This configuration outlines the 
parameters of the data being imported. This includes such information as
format of the data, the types of records and their field parameters (chara
length, position etc.). OTM includes a set of predefined import configuratio
for common data base types. You can then select the source from where
will import the data (e.g., disk drive, CD-ROM etc.).

The following is a summary of the steps required to import data using a 
predefined configuration.

Step 1: Access the Import utility.

Step 2: Select the import configuration components.

Step 3: Define the import configuration.

Step 4: Import the data.

Import data using a custom configuration
To import data using a custom configuration, you must first define the imp
configuration. This configuration outlines the parameters of the data bein
imported. This includes such information as the format of the data, the ty
of records and their field parameters (character length, position etc.). You
then select from where you will import the data (e.g., disk drive, CD-ROM
etc.).

The following is a summary of the steps required to import data using a 
custom configuration.

Step 1: Access the Import utility.

Step 2: Define the import configuration components.
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Step 3: Define the import configuration.

Step 4: Import the data.

Access the Import utility
To import data using a predefined or custom configuration, access the Im
utility. Depending on which application you are using, the Import utility ma
be accessed from several locations.

For example, if you are accessing the Import utility from the OTM Teleco
Billing System, then you would click File | Import  from its main window. The 
Import dialog will appear allowing you to select from a list of predefined 
configurations or add your own custom configuration. Once you have 
selected the predefined configuration and the source directories, click Go to 
import the data.

Selecting import configuration components
The Import (Select an Import Configuration) function is used to select a 
predefined import configuration. To select a predefined import configurati

1 Click the import configuration name from the “Select an Import 
Configuration” drop-down list box. 

2 To define the components of the imported file, click the ellipsis 
command button (…). The Import Configuration Definition dialog will 
appear allowing you to select the tables or data bases you wish to 
import. 

3 Once you have selected the predefined configuration and the source 
directories, click Go to import the data.
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Import configuration list
If you are creating a new import configuration, then clicking the ellipsis 
command button (…) will access the Import Configurations List dialog. The
Import Configurations List dialog contains a list of predefined import 
configurations. To create a new configuration:

1 Click Add . This will access the Import Configuration Definition dialog 
where you can enter the importing information. 

Note: To edit an existing configuration, click the name of the 
configuration and click Edit . Again, this will access the Import 
Configuration Definition dialog where you can enter the new definition. 

2 To select an import configuration, click the name of the import 
configuration name to highlight in the list and OK to select it.

Defining an import configuration
The Import Configuration Definition function is used to select and define 
type of data being imported into the OTM data bases. Enter the following
information to define the import configuration:

1 Configuration Name: Enter the name of this configuration. The name 
helps to identify this configuration from others in the Import 
Configurations List.

2 Tables/Database menu tree: Select the type of tables into which the 
data will be imported. For example, if you are importing data into the 
OTM Telecom Billing System, you can select from: Call Records; 
Organization Levels; and Tax Types to import data into these data 
bases.

3 File/Database Type: From this drop-down list box, select the type of 
data being imported. Select from the following:

— dBase IV

— Excel 5

— Microsoft Access

— ODBC Data Source

— Text File (Comma Separated Values )

— Text File (Fixed Width)
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4 File/Database Location: To select the source of the imported data 
base file (i.e., the directory or drive from which the file will be imported), 
click the ellipsis command button (…) next to the File/Database 
Location field. From the Directory Location Form dialog that appears, 
select the drive and directory of the data base file being imported and 
click OK. Notice that this will appear in the File/Database Location 
field.

5 Import Profile Format: To select the format of the imported file, click the 
Format  button. This will access the Import Format dialog in which you 
can select the field properties for the imported file.

6 File/Table Name: From this drop-down list box, select the filename of 
the data base being imported.

7 Update Activity: This option determines how this data base will be 
updated. Select from the following options.

Table 6
Import update activity options

8 Purge records after writing: Turn on this check box to delete the 
records from the source file after they have been successfully written 
to the destination file.

Note: This action is not reversible. Therefore, use caution if selectin
this option.

9 Description: This field describes the contents of the table selected from 
the Tables/Database Name menu tree.

Option Meaning

Append non matching Appends non-matching records

Update matching Updates matching records

Update matching or append Either updates or appends as 
appropriate

Delete matching! Deletes matching records

Delete all rows then append! Purges entire table before appending

Recreate table then append! Drops and recreates table before 
appending
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10 Once you have entered this information, click OK to save these edits 
and return to the previous dialog.

Import data

11 Once you have selected the import information, click Go to proceed. 
The Import utility will then attempt to import this data into the 
site/system files.

Example data import
The following example will demonstrate how to import data using a 
predefined configuration.

This example outlines how to import data from the MAT Call Accounting
Employee Database to a site/system while running the OTM Telecom Bill
System. This example uses a fictitious import configuration entitled: MAT 
Import . For this example, the Employee Database file is located in C:\MAT . 
The filename is EMPLOY1.DAT.

1 From the Telecom Billing System main window, click File | Import . The 
Import dialog appears.

2 From the Select an Import Configuration drop-down list box, select 
MAT Import .

3 To select the import values, click the ellipsis command button (…). The 
Import Configuration dialog appears.

4 From the data base name menu tree, select Employee Database .

5 To select the source of the imported data base file, click the ellipsis 
command button (…) next to the File/Database Location field.

6 From the Directory Location Form dialog, select: C:\MAT  and click OK.

7 From the File/Table Name drop-down list box, select: EMPLOY1.DAT .

8 From the Update Activity drop-down list box, select the default: 
Append All .

9 To proceed with the data import, click Go.
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Restore Call Database using Import utility
This example demonstrates how to restore the Telecom Billing System's 
Database from the A: drive. To restore the Call Database, perform the 
following steps.

1 Access the Import utility by clicking File | Import  from the Telecom 
Billing System main window.

2 Select Merge CDR/Costed Data  as the Import Configuration.

3 To define the parameters for this restore operation, click the ellipsis 
command button (…) next to this list box. The Import configuration 
dialog appears listing CDR/Costed Data Merge as the destination (To 
Telecom Billing System).

4 In the File/Database Location field, enter the source of this restore 
operation. For example, enter: A:\  for a floppy disk drive. Click the 
ellipsis command (…) to view a list of available drives.

5 If you wish to restore a range of call records based on their dates, then 
click the ellipsis command (…) next to the Filter drop-down list box.

6 In the Filters dialog that appears, create a new filter definition and enter 
the range of call dates for this filter.

7 Select this new filter name from the Filter drop-down list box.

8 Click Go to proceed with the restore operation.

Export utility
The Export utility is used to export data from the OTM data bases to an 
external source. This is useful for archiving a range of data for later retrie
For example, if you wish to archive a range of CDR data to an external sou
then you would use the Export utility to select a range of data and specify
external source.

When exporting data, you can select from a predefined export configura
or you can define your own custom configuration.
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Export data using a predefined configuration
To export data using a predefined configuration, you must first select the
configuration and its component values. This configuration outlines the 
parameters of the data being exported. This includes such information a
format of the data, the types of records and their field parameters (chara
length, position etc.). OTM includes a set of predefined export configurati
for common data base types. You can then select from where you will ex
the data (e.g., disk drive, CD-ROM etc.).

The following is a summary of the steps required too import data using a
predefined configuration:

Step 1: Access the Export utility.

Step 2: Select export configuration components.

Step 3: Define export configuration.

Step 4: Export the data.

Export data using a custom configuration
To export data using a custom configuration, you must first define the ex
configuration. This configuration outlines the parameters of the data bein
exported. This includes such information as the format of the data, the ty
of records and their field parameters (character length, position etc.). You
then select to where you will export the data (e.g., disk drive, CD-ROM e

The following is a summary of the steps required to export data using a 
custom configuration:

Step 1: Access the Export utility

Step 2: Define export configuration components

Step 3: Define export configuration

Step 4: Export the data
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Access the Export utility
To export data using a predefined or custom configuration, access the Ex
utility. Depending on which application you are using, the Export utility ma
be accessed from several locations.

For example, if you are accessing the Export utility from the Telecom Billi
System, then you would click File | Export  from its main window. The Export 
dialog will appear allowing you to select from a list of predefined 
configurations or add your own custom configuration. Once you have 
selected the predefined configuration and the source directories, click Go to 
export the data.
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Select export configuration
The Export (Select an Export Configuration) dialog is used to select a 
predefined export configuration. To select a predefined export configurat

1 Click the export configuration name from the “Select an Export 
Configuration” drop-down list box. 

2 To define the components of the exported file, click the ellipsis 
command button (…). The Export Configuration Definition dialog 
appears allowing you to select the tables or data bases you wish to 
export. 

Note: If you are creating a new export configuration, then clicking the 
ellipsis command button (…) will access the Export Configurations List 
dialog. 

3 Once you have selected the predefined configuration and the 
destination directories, click Go to export the data.

Export configurations list
The Export Configurations List dialog contains a list of predefined expor
configurations. To create a new configuration: 

1 Click Add . This will access the Export Configuration Definition dialog 
where you can enter the exporting information. 

Note: To edit an existing configuration, click the name of the 
configuration and click Edit . Again, this will access the Export 
Configuration Definition dialog where you can enter the new definition. 

2 To select an export configuration, click the name of the export 
configuration name to highlight in the list and OK to select it.
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Export configuration definition
The Export Configuration Definition dialog is used to select and define th
type of data being exported from the OTM data bases. Enter the followin
information to define the export configuration:

1 Configuration Name: In this field, enter the name of this configuration. 
This is for informational purposes and helps to identify this 
configuration from others in the Export Configurations List.

2 Tables/Database menu tree: From this menu tree, select the type of 
tables from which the data will be exported.

3 File/Database Type: From this drop-down list box, select the type of 
data being exported.

4 File/Database Location: To select the destination of the exported data 
base file (i.e., the directory or drive to which the file will be exported), 
click the ellipsis command button (…) next to the File/Database 
Location field. From the Directory Location Form dialog which 
appears, select the drive and directory of the data base file being 
exported and click OK. Notice that this will appear in the File/Database 
Location field.

5 Export Profile Format: To select the format of the exported file, click the 
Format button. This will access the Export Format dialog in which you 
can select the field properties for the exported file.

6 File/Table Name: From this drop-down list box, select the filename of 
the data base being exported.

7 Update Activity: This option determines how this data base will be 
updated. Select from the following options.
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Table 7
Export update activity table

8 Purge records after writing: Turn on this check box to delete the 
records from the source file after they have been successfully written 
to the destination file.

Note: This action is not reversible. You should therefore use caution 
if selecting this option.

9 Description: This field describes the contents of the table selected from 
the Tables/Database Name menu tree.

10 Once you have entered this information, click OK to save these edits 
and return to the previous dialog.

Export data

11 Once you have selected the export information, click Go to proceed. 
The Export utility will then attempt to export this data from the 
site/system files to the external device or file.

Option Meaning

Append non matching Appends non-matching records

Update matching Updates matching records

Update matching or append Either updates or appends as 
appropriate

Delete matching! Deletes matching records

Delete all rows then append! Purges entire table before appending

Recreate table then append! Drops and recreates table before 
appending
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Archiving Call Database using Export utility
This example demonstrates how to archive the Telecom Billing System's 
Database to the A: drive. To archive the Call Database, perform the follow
steps:

1 Access the Export utility by clicking File | Export  from the Telecom 
Billing System main window.

2 Select Archive CDR/Costed Data  as the Export Configuration.

3 To define the parameters for this archive operation, click the ellipsis 
command button (…) next to this list box. The Export configuration 
dialog will appear listing CDR/Costed Data as the source (From 
Telecom Billing System).

4 In the File/Database Location field, enter the destination of this archive 
operation. For example, enter: A:\  for a floppy disk drive. Click the 
ellipsis command (…) to view a list of available drives.

5 If you wish to archive a range of call records based on their dates, then 
click the ellipsis command (…) next to the Filter drop-down list box.

6 In the Filters dialog that appears, create a new filter definition and enter 
the range of call dates for this filter.

7 Select this new filter name from the Filter drop-down list box.

8 Select the Purge Records After Writing  option to delete the range of 
call records from the original Call Database once the call records have 
been copied to the external source. This will clear up disk space on 
your PC.

9 Click Go to proceed with the archive operation.
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Corporate Director y
OTM’s Corporate Directory is a flexible tool for defining and generating 
reports of station data associated with a terminal number. Report data is
provided by Station Administration. Data can include about 100 different
data fields, including the name, extension, location, and department 
associated with each terminal number.

Note: Corporate Directory requires that you have Station 
Administration and Microsoft Excel 95 or later. 
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Defining and generating reports
To access the Corporate Directory tool:

1 Select Corporate Directory  from the Utilities  menu of the Navigator 
window. The Corporate Directory window appears where you can view 
and manage reports. 

You can use predefined reports or define new reports.

To define a report: 

1 Select Add Report  from the Configuration  menu. The New Report 
property sheet appears, where you can define data fields, column 
names, column order, and directory location for the report.

To generate a report: 

1 Select Generate Report  from the File  menu. 

2 Select Now  to immediately display the report in a Microsoft Excel 
window, print the report, or save it to a file. 

Or

Select Schedule  to have the report automatically generated to a 
printer or Excel file at a later time. Select a report by name, then select 
Open  to display the most recently generated version of that report.

Note: Before you can generate reports, Station Administration data m
be downloaded from the switch and you must have at least one custo
configured for each system.

See “Generating Reports” in the Station Administration User Guide for more 
information.
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Database Com pact/Repair Utilit y
This chapter describes its functions and purpose of the OTM Database 
Compact and Repair utility. For complete details on using this utility, refer
the online Help included with the software.

Use the Compact and Repair utility to compact or repair the OTM data b
files for specific sites and systems. This utility will compact or repair any
Microsoft Access format data base files of the same version as OTM (e.
Access 97).

The following are two common reasons to compact data base files:

• Increase in size

CDR data that is accessed by OTM Telecom Billing System and OT
Directory is stored in data base files. These data base files grow as 
records are added and deleted. Periodically, the data base files shou
compacted to increase access performance. This is especially true of
active files such as CDR data base files.

• File fragmentation

As you update the OTM data bases, the files can become fragmented
use more disk space than necessary. Use the Compact command to
compact these data bases and optimize the disk space used by thes
base files. Compacted data bases can often be accessed more quic
This will save time and system resources when you perform such 
operations as data base backups.
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In some cases, the OTM data bases can become corrupted and may no 
be accessible by the OTM applications. Use the Repair command to try 
repair these data bases so they can be accessed by these applications.

Note: You cannot run this utility for a specific system if you are runnin
an application within that system. Before proceeding with this utility,
exit from the application that is running within that system.

To compact a data base:

1 Click the desired system in the OTM System menu tree. 

2 Select Compact from the Utilities menu. The Compact Database 
dialog appears. 

CAUTION
This utility creates a temporary copy of the data bases as they are 
compacted. Therefore, you must have enough disk space for both the
original and the duplicate data bases. This operation will fail if the 
system runs out of disk space.
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3 Specify the files you wish to compact or repair and click Compact .

Figure 33
Access Database Compact/Repair Utility window
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Regional Settin gs
Currency Settings, located under Regional Settings, includes informatio
about local and alternate currencies. The Optivity Telephony Manager 
(OTM) applications use this information to display costs.

Local Currency
The Local Currency tab contains information about the local currency tha
used to display costs in the Optivity Telephony Manager (OTM) applicatio
This is useful in situations where a single system manages and processe
from many countries and you wish to report costs in different currencies
across different systems. Each system could represent sites in different 
countries. Their costs could then be expressed in their respective local 
currency.

Currency information, by default, is derived from the client PC's regional
settings. However, there are cases where different systems are required
operate with different currencies. In order to facilitate this, OTM allows y
to define currency settings for any system as required. In addition, defau
settings can be configured from the OTM Navigator main window, which c
also be used by the OTM systems. These default settings are used by a
system that does not have its own settings defined. This is useful in an 
installation where the majority of systems are operating in a common 
currency and only a few are operating in a different currency. In this case,
can set the default currency settings for the majority of the systems, and
will only need to configure the exceptions.

To define the local currency, click Configuration | OTM Regional Settings  
from either the OTM Navigator window or the system window. Select fro
the following options.
OTM Common Services User Guide



Page 114 of 292  Regional Settings

 
nal 
ws 
y). 
is 
ion 
e 

 
or 
or 
ill 
y 

g., 

). 
ard 

need 
r the 

tead 

 
 the 
Use System Setting (Navigator level only): Turn on this check box to have
OTM use the currency settings defined in the client PC’s Windows Regio
Settings. Notice that the remaining fields will be updated with the Windo
Regional Settings currency information and will appear grayed (read-onl
You will not be able to edit these fields if you select this option. Since th
option is only available at the Navigator level, you can only select this opt
for the Navigator main window. By default, this option will be enabled (th
check box will be turned on).

Use Default Setting (System level only): Turn on this check box to have the
system use the default currency settings that you defined in the Navigat
window. Notice that the remaining fields will be updated with this default (
shared) currency information and will appear grayed (read-only). You w
not be able to edit these fields if you select this option. This option is onl
available from a system window.

Enter the local currency values in the following fields.

Currency Name: In this field, enter a descriptive name of this currency (e.
US Dollars ).

Appearance Samples: These read-only fields will display samples of the 
costs based on the selected currency settings (e.g., $123,456.78 and 
($123,456.78)).

Currency Symbol: In this field, enter the symbol for this currency (e.g., $
This will appear next to the cost values on report summaries. If you keybo
does not support the currency symbol that you wish to use, then you may 
to enter it using alternate key codes. For example, to enter the symbol fo
Euro dollar, press and hold the [Alt]  key and enter: 0128 on your numeric 
keypad. The Euro dollar symbol will appear. If a black square appears ins
of this symbol, then your system font does not support this character. It 
should, however, still appear correctly on the printed report.

Position of Currency Symbol: From this drop-down list box, select how the
currency symbol will appear next to cost values. The “*” represents where
symbol will appear with respect to the value. For example, *1.1 indicates that 
the currency symbol will appear before the values (e.g., $1.00).
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Negative Number Format: From this drop-down list box, select how 
negative values will be displayed. For example, (*1.1) indicates that negative 
numbers will appear with parentheses around them (e.g., ($1.00)).

Decimal Symbol: In this field, enter the symbol that will be used for the 
decimal (e.g., for the amount $1,000.00, enter: .).

Number of Digits after Decimal: In this field, enter the total number of 
digits that will appear after the decimal (e.g., for the amount $1,000.00, en
2).

Digit Grouping Symbol:  In this field, enter the symbol that will be used to
separate digit groups when displaying currency values (e.g., for the amo
$1,000.00, enter ,).

Number of Digits in Group:  In this field, enter the number of digits that will
be separated by the digit grouping symbol (e.g., for the amount $1,000.0
enter: 3).

Once you have entered these settings, click Apply  to save them and remain in
this tab. Click OK to save these settings and exit to the previous window.

Alternate Currency
The Alternate Currency tab contains information about any alternate 
currencies used when displaying costs in OTM reporting. This is useful i
situations where you wish to have reports display monetary values in tw
separate currencies. For example, European countries could display sum
costs in their local currencies and in the new Euro currency.

You can either define the alternate currency settings for specific system
have them use the default settings defined in the Navigator level. The 
alternate currency defined in the Navigator window will be used as the def
alternate currency. Any systems that do not have alternate currency set
defined for them will use the default currency settings defined at the 
Navigator level. As well, you can specify that a system should use the de
currency settings.

To define the alternate currency, click Configuration | OTM Regional 
Settings  from either the OTM Navigator window or the system window. 
Select from the following options.
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Use Default Setting (System level only): Turn on this check box to have the
system use the default alternate currency settings you entered in the Navi
window. Notice that the remaining fields will be updated with this curren
information and will appear grayed (read-only). You will not be able to e
these fields if you select this option. This option is only available from a 
system window.

Enable Alternate Currency (Navigator and System level): Turn on this 
check box to enable alternate currency settings to be displayed on syste
billing reports. If you disable this option (i.e., turn off this check box), the
remaining fields will appear grayed (read-only) and the alternate currenc
will not be included in your reports.

Enter the alternate currency values in the following fields.

Currency Name: In this field, enter a descriptive name of this currency (e.
US Dollars ).

Appearance Samples: These read-only fields will display samples of the 
costs based on the selected currency settings (e.g., $123,456.78 and 
($123,456.78)).

Currency Symbol: In this field, enter the symbol for this currency (e.g., $). 
This will appear next to the cost values on report summaries. If you keybo
does not support the currency symbol that you wish to use, then you may 
to enter it using alternate key codes. For example, to enter the symbol fo
Euro dollar, press and hold the [Alt]  key and enter: 0128 on your numeric 
keypad. The Euro dollar symbol will appear. If a black square appears ins
of this symbol, then your system font does not support this character. It 
should, however, still appear correctly on the printed report.

Position of Currency Symbol: From this drop-down list box, select how the
currency symbol will appear next to cost values. The “*” represents where
symbol will appear with respect to the value. For example, *1.1 indicates that 
the currency symbol will appear before the values (e.g., $1.00).

Negative Number Format: From this drop-down list box, select how 
negative values will be displayed. For example, (*1.1) indicates that negative 
numbers will appear with parentheses around them (e.g., ($1.00)).
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Decimal Symbol: In this field, enter the symbol that will be used for the 
decimal (e.g., for the amount $1,000.00, enter: .).

Number of Digits after Decimal: In this field, enter the total number of 
digits that will appear after the decimal (e.g., for the amount $1,000.00, en
2).

Digit Grouping Symbol:  In this field, enter the symbol that will be used to
separate digit groups when displaying currency values (e.g., for the amo
$1,000.00, enter ,).

Number of Digits in Group:  In this field, enter the number of digits that will
be separated by the digit grouping symbol (e.g., for the amount $1,000.0
enter: 3).

Currency Exchange Rate: In this field, enter the exchange rate for this 
currency against the local currency. For example, if the local currency is
U.S. dollar (US$) and the alternate currency is the Canadian dollar (Can
and the exchange rate is 1.49, then enter: 1.49 in this field. This means that 
US$1.00 is equivalent to Can$1.49.

Once you have entered these settings, click Apply  to save them and remain in
this tab. Click OK to save these settings and exit to the previous window.
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Access Server
The Access Server provides a command line interface (CLI) for remote 
access to the OTM server. From a remote terminal, you can dial in throu
modem or direct serial connection to access OTM server.

Once successfully logged in, you can:

• change Windows NT user passwords, 

• connect to different sites and systems as configured in Virtual Termi
Service (VTS, described on page 235). 

Note: CLI needs a dedicated modem. CLI cannot share the modem w
Win NT RAS or other services.

CLI  Status window
The CLI launches at OTM Server startup. The status window displays C
status messages.

CAUTION
Access Server must be run under the Windows NT Operating System
as it will not function properly under any other operating system.

CAUTION
If you are not using Access Server, uncheck the “Launch 
Automatically” check box. This action prevents unnecessarily tying up
a COM port on the server.
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The following status messages may appear in the CLI window:

• Waiting for incoming call

• Answer call and authentication process in process  

Figure 34
CLI Status window
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 Access Server Page 121 of 292

 

 

CLI configuration window
The CLI configuration window (Figure 34) is used to define the following
OTM Server COM port settings:

Port - list of COM ports on the OTM Server
Data Speed of COM port - 4800, 9600, 19200, 38400
Data Bits - 5, 6, 7, 8 bits
Parity  - None, Odd, Even Mark, Space
Stop Bits - 1, 1.2, 2 bits
Session timeout (secs): if current session is idle for the specified time,

CLI disconnects the call.

Figure 35
CLI configuration window
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CLI Log File window
The Log File window allows you to turn the log option on or off and spec
the log file location. Log file logs all activities: user login, commands, etc

CLI Operation
From a different PC, dial into CLI on the OTM Server using HyperTermin
or equivalent Telnet application and enter an OTM userid and password to
in. Once logged in the following commands are available:

• Help or ?- lists all commands

• Status - list all VTS ports associated with configured systems

• Connect - connect to a system

• Exit - disconnect 

Figures 37 and 38 show the CLI commands.

Figure 36
CLI Log File window
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Figure 37
CLI Help commands
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Communication
Both the Terminal Server and Client can detect when their TCP socket 
connection is lost. In that case, they will log the error and/or notify the us
and reset themselves for another connection.

The base port number is determines the range of socket ports used to 
communicate with the Terminal Client. However, normally this should be l
as-is, and should not be changed unless the default port conflicts with ano
network application.

By default, the Terminal Server and Terminal Client communicates throu
network ports 4789 up to 5045 (4789 to send connection requests, 4790-
for up to 256 terminal sessions). Of course, the number of ports actually 
depends on the number of virtual ports configured.

An administrator can change the range of port numbers by doing the 
following:

• In the Terminal Server application, click the Clients button. In the Clie
Properties dialog, enter the new port number.

Figure 38
CLI Status and Connect commands
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• Edit the HTML page containing the applet. Make sure the applet's 
BASEPORT parameter matches the one in Terminal Server (default
=4789).  

Encryption
Data is encrypted, so that someone monitoring the network traffic does n
see plain ASCII data (which may contain user login, password, or other 
sensitive information).

Every packet sent between the Terminal Server and the Terminal Client i
bytes, and contains data that is masked with a key. This ensures that dat
easily readable, while keeping the overhead low for constant character I

Before sending a packet, the application picks a random location in a 
256-byte key (known only to the server and the client) and uses the 
subsequent bytes to mask the character data. In essence, every packet 
masked with one of 256 possible keys.

Figure 39
The BASEPORT parameter
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Backu p and Restore
OTM’s Backup and Restore utilities provide convenient options for 
safeguarding, cloning, and restoring OTM data on a PC. The Backup uti
lets you create a OTM backup file of PC-based system property and 
application data for any or all sites and systems. The Restore utility lets 
restore a backup file to the same or different sites and systems on the sa
other PCs.

Note: The Backup and Restore utilities have no affect on Meridian 1
data. To secure OTM data that has been uploaded to the switch, you 
use OTM’s Electronic Data Dump feature described on page 169.
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Media, files, and data types
You can create a OTM backup file on the PC’s hard drive, a network dri
diskettes and other removable disks, or any other available media that m
your requirements for convenience and file space.

All backup data is written to a single folder for each backup operation. T
folder includes the following files:

• Zip file (*.ZIP), the backup file in compressed format

• Log file (*.LOG), providing the backup file’s date; type; OTM version
and sites, systems, and applications by name

You can back up and restore data for all or any combination of the follow
OTM applications:

• Telecom Billing System

• Call Tracking

• ESN

• Station Administration

• Traffic Analysis

You can back up and restore data for these applications across multiple
and systems at the same time.

Applications are associated with specific sites and systems. All backups
application data include the system property data associated with the sele
site or system.

When you restore data from a backup file, you have the option not to restore 
system property data. This option is useful in cases where the destination
or system is pre-configured and you do not want to overwrite its system 
property data. For example, system property data such as communicatio
ports, modem configuration, and user ID and password, may be differen
from one PC to the next.
P0910103 Standard 1.0 July 2000
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Benefits
The Backup and Restore utilities provide several key benefits:

• cloning

• moving data offsite

• disaster recovery

Clonin g
The process of copying system property and application data associated
one site or system to another site or system is called cloning. Copying data to 
another site or system can be a great timesaver. It can save you from ha
to enter a large amount of similar data one item at a time.

After cloning selected data, you can simply focus on making whatever 
changes are necessary to the cloned data. This operation is very flexible
destination site or system can be new or already exist, and it can be on 
same PC or on another PC.

Note: If you back up data from one PC and restore it to another, you
must perform this operation under the same version of OTM. You can
back up data from a PC with an older version of OTM and then resto
the data to a PC with OTM. Upgrade the older version of OTM befor
performing this type of cloning operation.

Movin g data offsite
If you want to maintain or occasionally modify OTM data offsite, a OTM 
backup file provides the solution. You can restore the backup file on any
that has the same version of OTM installed.

When you finish modifying OTM data, create a new backup file. Then yo
can restore the modified data to the original or primary PC where OTM i
installed.
OTM Common Services User Guide
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Note: This operation works particularly well for modifying application
data. Remember not to restore system property data from one PC to 
another if the PCs need to have different configurations for the 
corresponding sites and systems.

Disaster recover y
An important part of safeguarding your OTM data is having a disaster 
recovery plan. This plan should consider who makes the backups, what
backed up, how often, on what media, and where the backups are store

The Backup utility includes a more comprehensive backup option that is
designed for disaster recovery. This option automatically backs up all sit
systems, and applications, and additionally saves user-created files suc
scripts and customized reports. Consider performing this type of backup
least once a month and storing the backup file in a safe place.

In the event of unrecoverable data loss, restore your disaster-recovery ba
file first. All file contents are restored to the PC. Then, if you have backu
for selected sites, systems, and applications that are more recent, restore
next.

Note: OTM executables and files that can be reinstalled from the OT
CD are excluded in a disaster recovery backup. If OTM executables ha
been damaged or lost due to a hard-disk crash, for example, you will n
to reinstall OTM on your repaired or replaced PC before restoring yo
disaster recovery backup.
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Running the Backup utility
To run the Backup utility:

1 Select Backup from the Utilities  menu of the Navigator window. This 
invokes a wizard to help you define the following parameters:

• Type of backup (single site, single system, all sites and 
systems, or disaster recovery)

• Applications (Call Accounting, Call Tracking, ESN, Station, 
and/or Traffic)

• Destination directory for backup files

• Temporary directory for working files created during the 
operation

Note: The destination and temporary directory screens display a 
computed space requirement for the files. You can back up and restore 
data for these OTM applications across multiple sites and systems at 
the same time.

2 The next screen to appear is a dialog box (Figure 40) that summarizes 
your choices. Click OK to start the backup operation, or Cancel  to 
return to the wizard and change your options.
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Figure 40
OTM Backup Information dialog box
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Running the Restore utility
To run the Restore utility:

1 Select Restore from the Utilities  menu of the Navigator window. This 
invokes a wizard to help you define the following parameters:

• Type of restore (single site, single system, all sites and 
systems, or disaster recovery)

• Specific backup file and destination directory

• Temporary directory for working files created during the 
operation

2 The next screen to appear is a dialog box that summarizes your 
choices. Click OK  to start the restore operation, or Cancel  to return to 
the wizard and change your options.
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Director y Services
The OTM Directory feature allows you to input end user data through th
OTM applications, such as Station Administration and Telecom Billing 
System, directly into the customer’s server. OTM Directory contains 
employee and organization details, with a number of fields that are comm
to both Directory and Station Administration. The two data bases are the
synchronized using the Audit functions (See Station Administration).

OTM Directory provides a number of tools to configure your company 
structure and create an employee data base:

• an Organization Hierarchy editor to define your business organizatio

• an Employee Selector to manage user data

• an External Parties editor to configure external party records

• a Roles/Project editor to create role and project groups within the 
organization.

• synchronization utilities to update Station Administration with all the 
changes made to Directory data.

Note: The data is scheduled for synchronization from the Utilities me
in the Navigator window. See “LDAP Synchronization” on page 155.

Access OTM Directory
OTM Directory is accessed from within the Station Administration Syste
window in the following ways:

• The Employee Selector, External Parties, Roles/Projects and 
Organizational Hierarchy options available in the View menu.
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• The Directory button in the Station Set window (as shown in Figure 4
which is accessed by double-clicking on an individual station from th
list of stations in the Station Administration window

• From within the Telecom Billing System (TBS) Edit  menu. For more 
details, see the Optivity Telephony Manager Telecom Billing System 
User Guide.

Note: The links between Station Administration and OTM Directory a
described in more detail in the Optivity Telephony Manager Station 
Administration User Guide.

Figure 41
Employee Selector window from Directory button in Station Set
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Organizational Hierarchy Editor
The Organizational Hierarchy Editor allows you to create and edit the 
structure of your company. You build an organization tree representing t
different organization nodes in your corporation such as, divisions, 
departments, projects, and project teams. You can place each organizat
node at its level in the hierarchy. After defining an organization node in t
structure, you can assign employees to the node using the Org. Path fie
the Employee Editor.
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Access the Organizational Hierarchy Editor
To access the Organizational Hierarchy Editor, select Organizational 
Hierarchy under the View menu in the System window. 

The Organizational Hierarchy window is where you define the structure 
your organization. The left side of the window shows the organization 
hierarchy tree. The right side of the window is the Employee Selector 
providing a list of employees related to the selected organization node.

Figure 42
Organizational Hierarchy Editor, Levels Tab
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Define organization levels
Before you begin adding organization nodes to the tree, define the level
the organizations in your company. The levels represent the structure of 
company. For example, the company can have divisions, departments w
divisions, and projects within departments. You can define a maximum o
different levels.

1 Click the Levels tab. The tree displays the levels defined for the 
structure. If you have not yet entered the structure for your 
organization, the window contains a default menu tree with the 
Organization, Division and Department levels.

2 Click the level where you want to define a new level.

3 Right mouse click to open the Add New Level dialog.

4 Type the name of the new level and click OK.

To delete a level, select the entry and click the Delete key on the toolba

As shown in the example in Figure 42, the levels are defined as:

• corporation

• divisions within the corporation.

• departments within the division

• projects within the department

• employee teams within the project. 
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Add an organization node
To add an organization node:

Note: You must define an organization level before you can add an 
organization node at that level. See “Define organization levels” on 
page 139.

1 Select the Organizations tab (Figure 43).

2 Select the name of the organization in the tree where you want to add 
a new organization node. For example, if adding a new department to 
a division, select the name of the division.

3 Click the right mouse button and select Add New Node or click the Add 
icon (the toolbar button with the plus sign). The new node appears in 
the tree. For example, if adding a new division, Division appears in the 
tree.

4 Click the right mouse button and select Rename to give the new node 
a name. Type over the name.
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Figure 43
Organizational Hierarchy Editor, Organizations Tab
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Delete an organization node
To delete an organization node:

1 Select the organization node in the tree.

2 Click the Delete button (toolbar button with the X). The node 
disappears from the tree.

Employee Selector Window
The right pane of the Organizational Hierarchy window consists of the 
Employee Selector window. 

Note: The Employee Selector window is also displayed as an individ
window by clicking on the Directory button in the Station Set window
(Figure 41).

This window displays the list of current Employee entities in the Director
database, and allows you to create a new employee entity, add it to you
organizational node, and to edit the details of an existing entity.

The icons in the Organization Hierarchy toolbar allow you to edit the 
Employee records listed or create new Employee, Roles/Projects or Exte
Parties records to be added to your organizational node. As they appear 
left to right, they allow you to:

• Add new record: select a record type (Employee, External Party, 
Role/Project) from the Entity Selector. You can then add a new 
Employee record to the database (which opens the Employee Editor
add a new Roles/Projects record (which opens the Roles/Projects Ed
or a new External Party record (which opens the External Parties Ed

• Delete record: delete the selected record from the database. See “De
employees” on page 144.

• Edit Record: edit the selected record. This opens the Employee Edit
window, in which you can edit the Employee details 

• Find : search for a specific record. Enter a text string and select a fie
from ‘ID’, ‘Entity Type’ or ‘Name’ by which to search the database. Se
“Search for an employee” on page 144.

• Sort Ascending: sort the employee records in ascending order. See “S
the employee list” on page 145.

• Sort Descending: sort the employee records in descending order.
P0910103 Standard 1.0 July 2000
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• Refresh View: refresh the list following changes

• Move First/Previous/Next/Last: move the cursor to the top of the list,
to the previous entity to the one selected, to the next entity to the on
selected, or to the end of the list.

• Help: consult the On-Line Help system.

Add an employee to an organization node
To add an employee to an organization node: 

1 Select the organization node in the tree.

2 Click the Add button (toolbar button with the plus sign). The Entity Type 
Selector window opens.

You have the option to add a new Employee, External Party or 
Role/Project. When you select a type, the Editor for that type is 
displays. In this case, select Employee

3 The Employee Selector window opens. Select the employee you want 
to assign to the selected organization node.

Edit employee data
To edit employee data:

1 Select the organization node in the tree. The names of the employees 
appear in the Employee Selector window.

2 Select the name of the employee you want to edit.

3 Click the Edit button (toolbar button with the pencil). The Employee 
Editor opens. See “Edit employee data” on page 151.
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Delete employees
To delete an employee from an organization node:

1 Select the organization node in the tree. The names of the employees 
appear in the Employee Selector window.

2 Select the employee you want to delete.

3 Click the Delete button (toolbar button with the X). The employee 
disappears from the list.

Note: This action deletes the Employee from the Organizational Nod
but the Employee Entity still exists in the OTM Directory database. T
Entity can only be removed from OTM Directory through the Employe
Selector window, as accessed through the Directory button in Statio
Administration. For more details on the link between Station 
Administration and OTM Directory, see the Optivity Telephony 
Manager Station Administration User Guide.

Search for an employee
To search for a specific employee:

1 Select the organization node in the tree.

2 Click the Search button (toolbar button with the flashlight). The Find in 
Field search dialog displays.

3 Select the field you want to search from the drop down list in the Field 
box.

4 Enter the character string to search for in the Find What box.

Figure 44
Find in Field search dialog
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5 Click one of the following buttons:

• Find First - finds the first occurrence of the character string.

• Find Next - finds the next occurrence of the character string.

• Close - ends the search.

If the search finds a match, the employee’s name appears highlighted 
in the Employee Selector window.

Sort the employee list
To sort the employee list:

1 Select the organization node in the tree.

2 Click the column header of the column you want to sort in the 
Employee Selector window.

3 Click the Sort Up or Sort Down button (toolbar buttons with AZ Up or 
AZ Down). 
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Employee Editor
The Employee Editor allows you to add new employees and update empl
personal and job related data. The tabs on the right side of the window a
you to define the assets assigned to the employee. You can also define 
property assigned to the employee such as telephone and terminal num

Figure 45
Employee Editor Window
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Access the Employee Editor
There are several ways to access the Employee Editor:

• Click the Add or Edit button in the Organizational Hierarchy Editor 
window.

• Double-click an employee’s name in the Employee Selector window

To add a new employee:

1 The Employee Editor window opens with the Employee tab. The fields 
are blank. Enter the employee data as follows:

• Enter the employee information in the appropriate fields.

• How you access the Employee Editor determines if the Org. 
Path field shows a drop down selection box or not. If the drop 
down is active, the organization structure tree displays. Select 
the organization node for the employee from the tree. If the 
drop down box is not active, type the path to the organization 
node for the employee. 

• The Manager field has a drop down box where you select the 
employee’s manager.

• Click the envelope icon next to the Email field to enter the 
employee’s default email address or type the email address. 
This sends email to the employee with a corporate LDAP 
compliant server.

• Click the Publish check box to share the employee information. 
Do not click the check box if the information is private.

2 Enter the asset information as follows:

• Select New Asset in the Type column. The edit boxes below 
the grid become active.

• Select the type of asset from the drop down list in the Type 
field.

The asset types available identify the employee in the different 
OTM applications. Select from Account Code, Authorization 
Code, Extension, Phone Number, or Trunk Number. 
Depending on the type selected, a corresponding field entry 
will appear, into which you enter a value. 

• If the employee will be the prime user of this asset, turn on the 
Prime check box. This will allow several employees to use the 
same asset, while one employee in particular is the main owner 
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of the asset and will be assigned the cost.

• Click the Publish check box to share the employee asset 
information. Do not click the check box if the information is 
private

• Click the Apply button.

Click one of the following buttons:

• OK - saves the employee information and closes the window.

• Apply - applies the information configured

• Apply/New - saves the employee information and leaves the 
window open. The window is blank so you can add another 
new employee.

• Cancel - Closes the window without saving the employee 
information.

• Help - accesses the online Help system
P0910103 Standard 1.0 July 2000
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Enable web desktop end user access

1 Click the Additional Info tab in the Employee Editor window. See 
Figure 46.

2 Select Login Name  for the attribute Type.

3 Enter the user’s Windows NT Login Name for the attribute Value  (If NT 
is the authentication method chosen for desktop users).

Figure 46
Entering Login Name attribute
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4 Check the Publish  check box to enable synchronization with an 
optional LDAP compliant server.

5 Select User Group  for the attribute Type . See Figure 47.

6 Enter “EndUser”  for the attribute Value  to enable web desktop user 
access - both for LDAP and Windows NT access.

Figure 47
Entering User Group attribute
P0910103 Standard 1.0 July 2000
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Edit employee data
To edit employee data:

1 Click the Employee tab in the Employee Editor window. The selected 
employee data displays.

2 Edit the employee data as follows:

• Edit the employee information in the appropriate fields.

• How you access the Employee Editor determines if the Org. 
Path field shows a drop down selection box or not. If the drop 
down is active, the organization structure tree displays. Select 
the organization node for the employee from the tree. If the 
drop down box is not active, type the path to the organization 
node for the employee. 

• The Manager field has a drop down box where you select the 
employee’s manager.

• Click the envelop icon next to the Email field to automatically 
enter the employee’s default email address or type the email 
address.

• Click the Publish check box to share the employee information. 
Do not click the check box if the information is private.

Click one of the following buttons:

• OK - saves the employee information and closes the window.

• Apply/New - saves the employee information and leaves the 
window open. The Up and Down arrows appear on the right 
side of the window. Use these arrows to scroll to another 
employee record for updating.

• Cancel - Closes the window without saving the employee 
information.

3 Edit the property information as follows:

• Select the property you want to edit from the list of property in 
the grid at the right of the window. The edit boxes below the 
grid display the current values. 

• Change the information in the edit boxes. If the property is new, 
the system automatically checks the Prime field

• Click the Update button.
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Delete employee property
To delete property assigned to an employee:

1 Select the property you want to delete from the list of property in the 
grid at the right of the Employee Editor window.

2 Click the Delete key located below the grid.
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Excess DN report
An employee listing in the Directory lists all the extensions associated w
the employee. Normally, each of these extensions would match with a DN
Station Administration. However, when a set (and with it the DN) is dele
from Station Admin, the corresponding entry in the Directory is not remov
The old extensions remain in the Directory to provide information to billin
department. Thus there is a possibility that some of the extensions in the
Directory do not match with any DNs in Station Admin. These extensions
termed as 'Excess DNs'.

Station Admin has a facility to print off a report which lists these excess D
against their owner employee.
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This report can be run by selecting the File->Reports->Excess DNs menu 
item in the Station Administration window (Figure 48).

Figure 48
Excess DNs Menu
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LDAP Synchronization
The LDAP Synchronization utility synchronizes user data between the O
Directory, Station Administration data base, and the LDAP directory. LDA
Synchronization is a scheduled activity that runs in the background, or ca
performed manually.

In this chapter, LDAP server refers to an external corporate directory tha
Lightweight Directory Access Protocol (LDAP) compliant

There are two parts to LDAP synchronization:

• LDAP synchronizations are set up and scheduled from the Utilities me
in the Navigator window. 

• When a new user is added to the LDAP compliant external corporat
directory, you can manually add the user entry to the OTM directory 
the appropriate Meridian 1. Use the LDAP Synchronization menu in t
System window.

Before attempting to set up LDAP Synchronization you must know the 
address of the LDAP server, and also values for the Search Root, Bind to 
Server as, and Password boxes. In addition, you must know the server typ
and attribute names. OTM must be given the ability to write to the LDAP
server.

LDAP Synchronization is enabled for OTM Directory entries which are in t
“Published” status. Only entries in the LDAP compliant external corporat
directory that have matching unique identifiers (UIDs) in the OTM Directo
are synchronized. You can manually enter the UIDs in the OTM Director
entries or import them using the procedure outlined in “Import and Expor
Utilities” on page 93.
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To Access the LDAP Setup from the Utility Menu of the OTM 
Windows Navigator Window

Director y Server tab
The first tab “Directory Server” defines the LDAP Server. 

Enter the server information, then click the Test Connection  button to verify 
the settings.

Note: The Test Connections button currently verifies the LDAP Serv
address and Port Number only. 

Figure 49
Directory Server tab - LDAP Server Setup
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Mapp ing tab
This tab identifies how the data between the OTM Directory and the LDA
Server is synchronized.

To refresh the displayed attributes on the Server Attribute drop down me
highlight one item from the Attribute List and then press the ‘Get Attribute
button. To map individual data items, click on the OTM data element in t
list, select the mapping direction, and select the associated attribute in th
LDAP Server.

Only elements which you enable via the checkbox are synchronized dur
the scheduled synchronization periods.
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Figure 50
Mapping tab - LDAP Server Setup
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Synchronization tab
Use this tab to schedule the synchronization between the OTM directories
the LDAP Server. The list contains all Meridian 1 systems defined in the
OTM Navigator.

Note: Scheduled synchronization will only synchronize OTM Directory 
entries for which the "Published" attribute has been enabled. Synchroniza
will also only compare or update entries which have the same  "Unique 
Identifier (UID)" between OTM Directory and the LDAP Server. A UID ca
be manually set up using the LDAP Synchronization Utility (see page 161
by using the Import / Export capability (see page 163).

Check the systems to be synchronized and set the schedule. You can se
only compare data, or to actually perform updates.

Figure 51
Synchronization tab - LDAP Server Setup
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Logs tab
A background routine performs synchronization at the scheduled time, a
stores the results in a log in an OTM directory. This tab displays the log fi
The user can open a file for viewing, or delete a file.

Note: Synchronization results can also be viewed from the Web. See 
“Directory LDAP sync Report page” on page 220.

Figure 52
Logs tab - LDAP Server Setup
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LDAP Synchronization Utilit y
You can use this window to manually synchronize data between the LDA
Server and an OTM directory. In doing so, you assign a Unique Identifie
(UID) for each OTM Directory Entity. To start the utility, double-click on th
LDAP Synchronization icon in the System Window.

You can perform manual synchronization when a new employee is adde
the LDAP Server and you want to add the employee data into the approp
OTM directory.

Figure 53
LDAP Synchronization Utility
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OTM fields and LDAP attributes
LDAP attributes are mapped to OTM fields during synchronization (or 
manually by clicking on the Synch button, or at a scheduled time). The fie
are mapped according to the configuration set in the Mapping table (see
Figure 50).

When you press the ‘Add’ Button, the following LDAP attributes are copi
to OTM fields.

Table 8:
Mapping table for Adding an Employee

(* : The Telephone and Fax fields are not copied during the Add process

OTM Field LDAP Attribute

UID uid

Last Name sn

First name givenname

Job Title title

Manager manager

Department department or departmentNumber
(for Exchange)

Email mail

Telephone *

Fax *

Street postalAddress

City l

State st

Postal code postalCode
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Importing Attributes to OTM Directory
Use the Import/Export Utility to import data from external sources to the 
OTM Directory. The example that follows shows how to import a UID fro
an LDAP database to a user with an extension number in OTM Directory. 
same method can be used to import a UID using other data such as Mana
Name, E-Mail Address etc.

Importin g LDAP ID (UID) Usin g an Entit y's Extension Number 
(DN)
In the following example, the LDAP ID of a user (Alex Wong) is imported
using his extension number (7409).

Note: The entity should be the prime owner of the extension for this
import to be successful.

1 Create a text file that maps the extension number of the entity to 
his/her uid. The first row should state the name of the column: in this 
case column 1 is Extension and column 2 is the UID. More records can 
be added to the file. In this example, the file is named C:\extuidmap.txt, 
and contains the following text:

"Extension", "UID"
7409, wongldapid

2 Launch the Import/Export system. This can be launched from a 
number of applications, e.g. Telecom Billing System (TBS). The Import 
Configuration dialog is displayed (Figure 54).

a Select "Corporate Data Import" from the drop down list of types of 
Import Configuration.

Figure 54
Import configuration dialog box
OTM Common Services User Guide



Page 164 of 292  LDAP Synchronization
b Click on the ellipse button to launch the configuration.

3 In the resulting dialog, select the file from which you want to import 
data. In this case, this is the text file created in Step 1. Then press the 
Edit  button.

4 In the Import dialog box (Figure 55), select Corporate Data Views and 
check the Corporate Entity View item.

5 Select Text File (Comma Separated Values) from the drop down list of 
available File/Database Types.

6 Select the File/Database Location. In this example, the file created is 
stored in C:\.

7 Select the File/Table Name. In this example, this file is called 
extuidmap.txt.

Figure 55
Import dialog box
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Select Update Matching as the Update Activity. This indicates that only 
records satisfying the search criteria will be updated.

8 Click on the Format button to launch the format dialog to set the 
mappings.

The next step in the procedure is to map the extension and UID fields in the 
corporate directory to the correct columns in the text file.

9 Using the left double arrow button, clear the Selected Columns list.

10 Select the Extension Field by clicking on the EXTNAsset_ in the 
Available Columns List and then clicking on the right arrow button. This 
is the field in the corporate directory.

11 To map this field to the column in the text file that was created, select 
the proper External Column Name. In this example, the first column in 
the text file was called "Extension" (as shown in Figure 56).

Figure 56
Mapping extensions and UID field to Corporate Directory
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12 Ensure to check the Include in Alternate Key check box. This means 
that the extension will be used as the search criteria. The system will 
add the LDAP ID to the entity owning this extension  (i.e. the Prime 
Owner).

13 Using the same procedure, select the UIDAsset_ and map it to the 
"UID" external column. However, ensure not to check the Include in 
Alternate Key check box for this field.

14 Click on OK to close the format dialog and begin the Import. Click on 
the GO button in the configuration dialog (as shown in Figure 54). 
When the import is completed, the Corporate Data Import summary 
dialog box is displayed (Figure 57).

Here, we can see that one record was read in and one record was upda

Figure 57
Corporate Data Import summary
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15 The last step is to verify if the LDAP ID was added into the Corporate 
Directory. To do this, launch the Corporate Directory Editor. Click on 
the LDAP Synchronization icon, initiate a ‘Find in OTM, and the 
Employee Record. The Employee Editor confirms that the LDAP 
Unique ID for this user (wonglapid) is listed (Figure 58).

Figure 58
Employee Editor dialog box
OTM Common Services User Guide
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Electronic Data Dum p
OTM’s Electronic Data Dump (EDD) is a critical data base update operat
on the Meridian 1 switch. This operation dumps (saves) modified data fr
the switch’s resident memory to data base files on the switch’s hard disk
These data base files contain the active configuration information for 
phone-system terminals and users.
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Synchronizing and securing data
Using OTM’s Station Administration and ESN applications, you can mod
station data, Call Party Name Display (CPND) data, and Electronic Switc
Network (ESN) data. OTM stores these changes in its PC data base files
phone system cannot recognize these changes, however, until you uploa
modified data to the Meridian switch. This operation synchronizes switch
data with current OTM data on the PC.

Updating the switch’s data is a two-step process. The first step is to tran
modified OTM data from the PC to the switch’s resident memory. OTM’s
Station Administration and ESN applications include a Synchronize  menu 
for this purpose. The second step is to use OTM’s EDD feature to dump
modified data from the switch’s resident memory to the switch’s hard dis

To secure modified data at the switch, you must dump it to the switch’s h
disk. Optionally, your distributor technician can set up the switch so that y
also dump data to a diskette that you insert in the switch’s floppy drive. Po
interruptions erase all data in resident memory. When power is restored
switch data is automatically restored from its data base files on the hard d
Modified data that was not previously dumped to these data base files is lo
at the switch. Further, this data may be difficult to isolate in the PC’s OT
applications, since all previously uploaded data shares the same TRN 
(transmitted) status. For these reasons, always perform or schedule data 
dumps after uploading data to the switch.
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Accessing EDD
You can access EDD from the File  menu of the System window. The EDD 
selection is called Data Dump . This selection has its own submenu with th
options Now , Schedule , and View Log .

You can select Now  to perform the data dump immediately, Schedule  to set 
up the operation to run automatically, or View Log  to review status and error
information from the most recent data dump.

The data-dump operation takes just a few minutes. While modified OTM d
is being dumped at the switch, status and error information about the da
dump is actively logged to the PC. Both Now  and View Log  open the EDD 
Data Dump dialog box for viewing or reviewing, respectively, this status a
error information. This log is saved to the PC’s hard disk and each data d
overwrites the existing log file.

Note: To access error information, open the Events window after th
data dump and double-click each error event of interest. This invoke
help that is specific to each error.

The Schedule  option opens the Scheduling dialog box. Here you can sele
when and how often you want to dump data at the switch. It is best to sche
this operation for a time soon after uploading OTM data to the switch. Th
OTM Scheduler sends the job to the Queue Manager at the designated 
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Figure 59
EDD Data Dump dialog box
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Responding to a connection failure
If you are connected to M1 system and that connection fails, a warning 
message appears. See Figure 60. You are given the following options:

• Close all system windows and reconnect to the system

• Leave the system windows open so that you can copy or print any o
of the following information:

— Command results in the System Terminal window or any open 
Maintenance window.

— Alarms or events in the System Event Log.

— Maintenance window objects, such as network loops within the 
Network Loops window.

Note: When you have finished printing the desired information, clos
the system window and reconnect to the system.

• Attempt to reconnect to the system.

Figure 60
Connection Failure dialog
OTM Common Services User Guide
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Event Lo g Viewer
This chapter contains a general overview of the Event Log Viewer. It 
describes its functions and purpose. For complete details on how to use
Event Log Viewer, refer to the online Help.

Overview
Use the Event Log Viewer to view the records of all operations that are r
from the Optivity Telephony Manager. The Event Log Viewer displays th
event records stored in the Event Log. The Event Log Viewer also has 
features such as event sorting and filtering.
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Interface
Select Event Log Viewer  from the Maintenance  menu of the OTM Navigator 
window. The main window of the Event Log Viewer displays the Event L
data in a report layout. Column headings display text describing the mea
of the data it contains. You can change the size of columns by dragging o
divisions that separate the each headings.

File menu
The File menu contains commands to open and close Event Logs, print E
Log reports, and maintain the Main Event Log.

View menu
The View menu commands allow you to change the way you view an Ev
Log .

Options menu
The Options menu allows you to save the settings you entered in the File
View menus.

Figure 61
Event Log Viewer window
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Tools menu
The Tools menu allows you to access the SNMP Trap Setting window 
(Figure 62).

The Trap Setting option enables SNMP Trap Setting and contains the 
following options:

Figure 62
SNMP Trap Window
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Trap Source
Agent IP Address:  An agent is an SNMP entity located on the managed
node. The Agent IP Address is the IP address of the agent entity (i.e., th
machine sending the trap). 

Enterprise OID:   The Enterprise OID is a unique value assigned to your
organization by the Internet Assigned Number Authority (IANA).

Trap Destination: 
Manager IP Address:  The Manager IP Address is the IP address of the P
that hosts the target SNMP Manager and receives the trap.

Community Name:  This name identifies the community string. The defau
name is "Public".

Timeout:   The Timeout value is a time interval in milliseconds and 
determines the length of time that applications wait for an SNMP agent en
to respond to a request.  

Number of Retries:  The number of times the system will attempt to conne
to the SNMP Manager.

Trap Option:
Critical Events:  This error indicates that the event resulted in a loss of d
or system functionality.

Major Events:  This error indicates the termination of a process that cou
result in other processes being terminated (e.g., a corrupt DLL).

Minor Events:  This error indicates that the event wasn't necessarily 
significant but might point to possible future problems.
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System Terminal
System Terminal helps you perform overlay-based tasks directly through
Meridian 1 TTY interface. System Terminal provides online, context 
sensitive help for overlays, prompts, and error messages. System Term
also provides a terminal emulation capability.

In the web environment, Terminal Client provides the same functionality
System Terminal. For information on Web System Terminal, see “OTM W
System Terminal” on page 236.

There are two versions of System Terminal to support two different 
connection types—Ethernet or PPP and Serial—as follows:

• Overlay Passthru is available on X11 release 22 and later systems 
connected to OTM using Ethernet or PPP. Overlay Passthru only 
supports access to the overlays. 

• VT220 provides similar functions for any Meridian 1 system using ser
connections, as well as terminal emulation for all application module
(such as Meridian Mail). VT220 is discussed in “VT220” on page 189

In release 22 and later switches, you access the overlays using the Syst
Terminal (Ethernet or PPP required) and access the application module
VT220. In pre-release 22 switches, you access both the overlays and 
application modules via VT220.
OTM Common Services User Guide
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Launching System Terminal (Ethernet or PPP required)
Once you connect to the system of interest, to launch System Terminal:

1 Select System Terminal  from the Maintenance  menu or toolbar in the 
System window. 

2 Enter your system user ID and password in the System Login dialog. 
Figure 63 shows the System Terminal window.

The System Terminal window displays all system events as they occur. It
gives you direct access to any overlay.

Figure 63
System Terminal window
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Note 1: For Ethernet or PPP connections, each active System Term
connection requires a pseudo-TTY (PTY) port. PTYs are software-o
I/O ports. The System Terminal and Maintenance Windows applicatio
use these ports to access the overlays.

Note 2:  Ethernet and PPP are available only for X11 Software Rele
22 and above with packages 296 and 243 equipped. 

OTM System Terminal window
The System Terminal window includes the following:

• An Enter Command  edit box in which you type overlay commands

• A Command Results  list box that displays your interaction with the 
overlays and the results

• Links to online help are available for the following:

— Help on the current overlay

— Help on the current prompt

— Help on the last or selected error message

— One-line description of prompts in the status bar

You use overlays just as you did before OTM was available. The one m
difference is that you type into an edit box rather than the last line of the
screen as with TTY and Terminal Emulation applications. You still use th
<Enter>  key to send the typed-in data (an overlay command or response
prompt).
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Using System Terminal
You can do the following from System Terminal:

• load an overlay as you normally would on a TTY or Terminal Emulatio
application

• cut or copy system events or overlay command results to the clipbo

• save or capture the command results to a file

• get help on a Meridian 1 error message

• get help on an overlay

• get help on a prompt

• monitor system events

Advantages over a TTY
You now have the following advantages over the old TTY:

• you can type in lower case and use the backspace key

• Copy  and Paste  in the Enter Command box (useful for repeated 
commands with only a TN change)

• scroll back in the command results

• Copy  and Print  the command results

• capture output to a file as well as to the screen

• Save the command results to a file
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Getting help on the current overlay
You can get more help on the currently loaded overlay using the Current 
Overlay  command in the Help  menu. The help file is organized in a similar
fashion to the I/O Guide.

Note: The Current Overlay  button or menu item is disabled when you
are not in an overlay.

Example
If you are in overlay 10, you can select Current Overlay  from the Help  menu, 
and then navigate within help to the CPND prompt sequence. You can click
on any prompt in the sequence. This displays the help window for that 
prompt—the same as help on Current Prompt .

Getting help on the current prompt
Figure 64 shows an example of the help you can get on an administratio
overlay. You load the overlay and respond to the prompts, one at a time. 
help guides you as you load the overlay and respond to the prompts.

Figure 64
Current prompt help example
OTM Common Services User Guide
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If an overlay is currently loaded, the Status Bar at the bottom of the wind
provides a short description of the current prompt.

If the one-line description is not enough, you can read a full description of
prompt in OTM Windows Navigator Help. Choose Current Prompt  from the 
Help menu.

Note: Help on the current prompt is disabled if you are not in an 
administration overlay.

To get help on any other prompt choose I/O Navigator from the Help menu.

Getting help on an error message
System Terminal can distinguish error messages from the other text in t
Command Results  list box. The Error Messag e command in the Help  menu 
provides the error description in OTM Windows Navigator Help.

You can get help on an error message in the following ways:

• double-click an error message anywhere in the Command Results

• select the Error message  command in the Help  menu to get help on the 
last error message (even if it is scrolled off the screen)

• select an error message anywhere in the Command Results, then s
the Error message  command in the Help  menu

• select the I/O Navigator  from the Help  menu

The error message help window appears when you select the Error message  
command in the Help  menu.

Note: You can also get help on Meridian Mail System Error and Eve
Reporting (SEER) messages using the I/O Navigator. 
P0910103 Standard 1.0 July 2000



 System Terminal Page 185 of 292

m 

 

 

o 
System Terminal menus
Detailed descriptions about the functions of each command in the Syste
Terminal menus are available by clicking the “Context-sensitive Help” 
button in the toolbar. System Terminal menus consist of:

• File

• Edit

• View

• Help

Toolbar
The System Terminal toolbar offers several useful shortcuts to the menu
commands. See Figure 65. 

Note: The Find  and Find Next  icons in the toolbar allow you to search
the Command Results for the text string that you enter in the Find box . 
Find  is case-sensitive. The search begins at the current location.

Using the I/O Navigator
The I/O Navigator displays a dialog box that allows you to quickly jump t
help on any overlay, prompt, command, or error message. Select I/O 
Navigator  from the overlay’s Help  menu or from the I/O Navigator  buttons 
in the appropriate Help files.

Figure 65
System Terminal toolbar

Find Box
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The I/O Navigator allows you to navigate through I/O reference help 
independent of your current context within the overlays. For example, you
not need to be logged into a system to look up an error message using th I/O 
Navigator. See Figure 66.

1 Type the overlay number, error message number, or prompt in the text 
entry field 

2 Click OK. 

Help information for the specified overlay, prompt, or error message 
appears.

Figure 66
I/O Navigator dialog
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67.
The Topics  button displays the general reference Help index. See Figure

The Cancel  button cancels a search.

Figure 67
Example Help Index for an error message
OTM Common Services User Guide
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Entering an overlay (LD XX) or error code mnemonic (ERR, BUG) takes y
to the contents page of the appropriate help file. Entering the error code
(BUG3001) or an LD number and a prompt takes you to the Help topic p

• If the prompt or error message you specify does not exist, the help se
dialog appears with the nearest match selected.

• If the overlay number or error message type do not exist, a “Help file 
found” information dialog appears.

• The I/O Navigator  command can be used from within Help. You do no
need to be connected to a switch.

• There are some combination overlays (for example, one help file 
describes two overlays). You can enter either of the overlay number
These cases are:

— LD 36 and LD 41

— LD 40 and LD 42

— LD 20, LD 21, and LD 22

— LD 84 and LD 85

• Leading zeros are not required in error messages. For example, ent
SCH22 or SCH022 will find the description for SCH0022.

• To look up Meridian Mail System Error and Event Reporting (SEER)
messages, enter XXXYY (where XXX is the message class, and YY
the message number—no mnemonic is required). For example, ent
11102.
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VT220
The VT220 application models the VT100/220/320 series of terminals to
up communications between your PC and the Meridian 1. With VT220, y
can connect to the Meridian 1 using a serial, PPP (point to point protocol
Ethernet connection. It supports the transfer of ASCII data during a 
communications session and provides normal TTY and VT220 access to
overlays that are not supported by the OTM applications.

Features
VT220 supports the following features:

• double-height, double-width, blinking, bold and underlined character

• complete graphic character set, including a special font for represen
control characters

• scrolling regions

• 80 and 132 column modes

• echo, no echo, local mode and autowrap on/off

• reverse video characters and reverse video screen

• cursor types—block, underline, vertical line, or none

• selectable cursor blink rate

• user-definable Tab stops

• programmable function keys

• display control mode

• national character sets
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Accessing VT220
Before accessing VT220, you must first select the type of terminal emula
session you require. To do so, perform the following steps:

1 Click once on the system name in the OTM Navigator to highlight it and 
click Properties  from the File drop-down menu (or simply right-click on 
the system name and click Properties ).

2 From the System Properties window, click the Communications  tab 
and select the desired settings file from the Terminal Emulation VT220 
Settings drop-down list box (e.g., MMAIL.INI).

3 Click the Applications  tab and click once on System Terminal 
(VT220) in the Applications list box to highlight it.

4 Select a communications profile for System Terminal (VT220) by 
clicking on the desired profile name in the Communications Profile 
drop-down list box.

5 Click OK to select these settings and return to the OTM Navigator.

To access VT220, perform the following steps:

1 From the OTM Navigator, select the desired site and system and click 
System Terminal from the Maintenance drop-down menu.

2 From the System Terminal Selection dialog which appears, click 
Serial (VT220)  and click OK.
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VT220 will attempt to connect to the terminal based on the communicati
criteria entered in the System Properties Serial Communications Profile 
this system. Once it establishes this connection, the VT220 main window 
appear listing the commands and graphical tools required for the emulat
session. See Figure 68. 

The following sections briefly list the main functions of VT220.

File menu
The File menu contains functions used to save the VT220 configuration, p
the contents of the terminal window, record and replay VT220 terminal 
emulation sessions and close the system.

The following is a summary of these functions:

• Save Configuration

• Save Configuration As

• Print

• Print Setup

Figure 68
VT220 window
OTM Common Services User Guide
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• Printer Fonts

• Capture

• Playback

• Close

The Save Configuration  and Save Configuration As  menu items are only 
available if you have selected a user defined terminal type (as defined a
‘Other’ VT220 type from the OTM System Properties Communications ta
Otherwise, they will appear grayed.

Edit menu
The Edit menu contains editing commands used to manipulate the text 
appearing in the main window.

The following is a summary of these functions:

• Copy

• Paste

• Select All

Configuration menu
Once you start VT220 from the system window of the OTM Navigator wi
a user defined type of terminal (as defined as the Other  VT220 type from the 
OTM System Properties Communications tab), then you can use the 
Configuration functions to customize the VT220 settings to suit your nee
The purpose of having the ‘Other’ type is to allow you to create multiple typ
of settings based on generic settings.

If you do not select ‘Other’ or a user defined type, then you will not requ
these functions to run VT220. The Configuration command will therefore
appear grayed.

Before you can customize the VT220 settings, you must first select the 
custom VT220 settings file OTHER.INI using the Communications tab fro
the OTM Navigator System Properties application. Refer to “Accessing 
VT220” on page 190 for more details on selecting this option. This file 
appears in the VT220 settings drop-down list box. When you launch VT2
P0910103 Standard 1.0 July 2000
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from this customizable terminal, you can then use the commands which
appear in the Configuration drop-down menu to change the settings for 
VT220.

Once you have edited the VT220 settings using these functions, you mu
then save the customized configuration file using the Save Configuration As  
command. Using this command, you can enter the name of this configura
file for use in later sessions.

VT220 includes a number of setting files which are predefined depending
the system to which you are connected. For example, M1.INI is a predefi
setting file used for a VT220 terminal emulation session with the Meridian
and MMAIL.INI is a predefined setting file for Meridian Mail. These settin
files provide the required VT220 settings and cannot be edited.

The following is a summary of the Configuration functions:

• Terminal Setup

• National Replacement Character Set

• Map Keyboard

• Program Keys

• Tab Setup

• Options

• Status Bar

View menu
The View menu contains toggles to adjust the display of the VT220 wind
as well as hide and display the Tool Bar, Status Bar and Keys Window.

The following is a summary of these toggles:

• Terminal

• Hide/Show Tool Bar

• Hide/Show Status Bar

• Hide/Show Keys Window
OTM Common Services User Guide
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Terminal menu
The Terminal  menu contains commands used to connect and disconnec
VT220 for a temporary communications setup. The Connect  and 
Disconnect  commands start and stop the terminal emulation. The 
Temporary Communication Setup  function temporarily creates a terminal
emulation session based on customizable connection criteria. This setup
only temporary for the current session. When you access VT220 again, it
use the criteria defined for this system in the OTM System Configuration  
function.

The following is a summary of these commands:

• Connect

• Disconnect

• Temporary Communication Setup

Help menu
In addition to the standard online help features for VT220, this Help  menu 
contains topics which provide help with the Overlay Enhancer and I/O er
messages.

The following is a summary of these Help items:

• Help Topics

• Current Overlay

• Current Prompt

• Error Message

• I/O Navigator

• About VT220

The Help Topics  menu item displays the help topics for VT220 only if you
select a user defined terminal type (as defined as the ‘Other’ VT220 type f
the OTM system Properties Communications tab). Otherwise, it will disp
the help topics for the Meridian 1 system.
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 System Terminal Page 195 of 292

I 

 

 in 

 
’, 

ed. 
f 
ll 

nt 

or 
r 

 

The Current Overlay , Current Prompt  and Error Message  menu items are 
only enabled if you are running a VT220 terminal emulation for the M1.IN
terminal type and the system is in overlay mode.

The I/O Navigator Help  function allows you to obtain information on specific
error messages.

The Overlay Enhancer  is an online context sensitive help function which 
allows you to obtain quick and direct access to overlay information while
an active terminal session with the Meridian 1.

The following Overlay Enhancer Help commands appear in the Help 
drop-down menu:

• Current Overlay

• Current Prompt

• Error Message

The Current Overlay  and Current Prompt  commands are only available if an
overlay program is loaded and the terminal session is of type ‘Meridian 1
‘PPP’, or ‘Ethernet’. Otherwise, they will be disabled and will appear gray
The Error Message  command will be available if the terminal session is o
type ‘Meridian 1’, ‘PPP’, or ‘Ethernet’. Otherwise, it will be disabled and wi
appear grayed.

Note: Selecting an error message in the VT220 window is not sufficie
to access the Overlay Enhancer help. Unlike the Overlay Passthru 
application which displays online help when you double-click the err
message, the VT220 help requires that you first double-click the erro
message and then click Error Message  from the Help drop-down menu.
This will then display help for the selected error message
OTM Common Services User Guide



Page 196 of 292  System Terminal

 a 
 

1 or 

il 

ian 
ard 
ress 
on 

101 
Keyboard mappings
VT220 uses standard keyboard mappings which, when incorporated into
terminal session, will match the appropriate VT keys and actions. These
default mappings, as shown in the following tables, allow you to run a 
terminal emulation session using the appropriate keys on a standard 10
102-key keyboard.

For example, if you are using VT220 to run Meridian Mail, the Meridian Ma
softkeys (which appear at the bottom of the menus and screens) will 
correspond to the appropriate function keys on your keyboard. The Merid
Mail softkeys correspond to the function keys F6 through F10 on a stand
101 or 102-key keyboard. Therefore, in a Meridian 1 session, you would p
F6 to select Softkey 1, F7 to select Softkey 2, etc. For more information 
the Meridian Mail softkeys, refer to the Meridian Mail System Administration 
Guide

Tables 9 through 11 list the keyboard mappings for VT220 on standard 
and 102-key keyboards. 
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Table 9 
Keyboard mappings - VT key

VT Key PC Key

PF1 Num Lock

PF2 Numpad Slash

PF3 Numpad Star

PF4 Numpad Minus

Find Insert

Insert Home

Select Delete

Up Arrow Up Arrow

Down Arrow Down Arrow

Left Arrow Left Arrow

Right Arrow Right Arrow

F6 F6

F7 F7

F8 F8

F9 F9

F10 F10

F11 F11

F12 F12

F13 Sys Rq

F14 Scroll Lock

Help F2

Do F3
OTM Common Services User Guide
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F17 Ctrl-F7

F18 Ctrl-F8

F19 Ctrl-F9

F20 Ctrl-F10

Table 10 
Keyboard mappings - VT action

VT Key PC Key

Remove Page Up

Next Screen Page Down

Prev Screen End

Hold Screen F1

Compose Unmapped

Delete Backspace

Keypad Command Numpad Plus

Keypad Enter Numpad Enter

Break F5

Long Break Shift-F5

Control Break Ctrl-F5

Print Screen Unmapped

Keypad 0 Numpad 0

Keypad 1 Numpad 1

Table 9  (Continued)
Keyboard mappings - VT key

VT Key PC Key
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Keypad 2 Numpad 2

Keypad 3 Numpad 3

Keypad 4 Numpad 4

Keypad 5 Numpad 5

Keypad 6 Numpad 6

Keypad 7 Numpad 7

Keypad 8 Numpad 8

Keypad 9 Numpad 9

Keypad Minus Ctrl-Numpad Minus

Keypad Period Numpad Del

Table 11 
Keyboard mappings - VT action scroll

VT Key PC Key

Scroll Left Ctrl-Left Arrow

Scroll Right Ctrl-Right Arrow

Scroll Up Ctrl-Up Arrow

Scroll Down Ctrl-Down Arrow

Table 10  (Continued)
Keyboard mappings - VT action

VT Key PC Key
OTM Common Services User Guide
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System Monitor
The OTM System Monitor is a Microsoft Windows executable program th
runs in the background on the OTM Server. System Monitor displays the
PC’s resources (such as, memory and CPU usage) and issues alarms w
system resources are low. The System Monitor utility allows you to do th
following:

• turn a system alarm on or off and define the conditions (where, when,
what type of alarm) for sending alarm messages

• enable the System Monitor to automatically start when Navigator sta

• view the virtual, physical, and total memory available

• view the total CPU usage information

• view the processes now running on the system

• view the applications now running on the system

• view the performance of the NT server

• ping another machine to test network connections
OTM Common Services User Guide
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Access System Monitor
Access the OTM System Monitor with the Microsoft Windows Run 
command. The path depends on your installation. However, you can loc
the System Monitor executable in the common services\program files  
folder.

Double-click the System Monitor executable file. The System Monitor ico
appears on the Windows task bar, and the System Monitor starts (the win
is minimized on your screen). From this window you can perform all of th
System Monitor functions

To enable or disable the System Monitor, select Options from the Option
menu in the System Monitor window
P0910103 Standard 1.0 July 2000



 System Monitor Page 203 of 292

tor 

e 
 the 
View the virtual, physical, and total memory available
To view memory information, select the Memory tab on the System Moni
window.

The tab displays the amount of virtual and physical memory available, th
total memory limit and the total memory now in use. The progress bar at
bottom of the tab graphically displays the Memory Usage percentage.

Figure 69
System Monitor - Memory Tab
OTM Common Services User Guide
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View Disk Usage information
To view usage information for the disk, select the Disk Usage tab on the
System Monitor window.  

Figure 70
System Monitor - Disk Usage Tab
P0910103 Standard 1.0 July 2000
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View CPU information
To view usage information for the CPU, select the Processes tab on the
System Monitor window.

The tab displays five columns of information for each process that is runn
The CPU usage is graphically displayed at the top of the tab. The tab disp
the following information:

• Processes: the name of the process
• ID:  the process ID
• CPU%:  the percentage of the CPU used for the process
• MEM USAGE:  the amount of memory used for the process
• VM SIZE:  the amount of virtual memory used for the process

Figure 71
System Monitor -Processes Tab
OTM Common Services User Guide



Page 206 of 292  System Monitor
View and disable applications running on the system
To view and disable applications running on the system, select the 
Applications tab on the System Monitor window.

To stop an application from running, select the application and click the End 
Task button.

Figure 72
System Monitor - Applications Tab
P0910103 Standard 1.0 July 2000
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View the performance of the server.
To view the NT server performance, select the Network tab on the Syste
Monitor window. The tab displays the number of bytes received and sent
second by the NT server. 

To view the performance of other machines: 

1 Select the Network tab on the System Monitor window.

2 Enter the IP address of the machine you want to view. 

3 Click the Ping button. The performance for the machine appears.

Figure 73
System Monitor - Network Tab
OTM Common Services User Guide
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Set up alarms
You can set up where to send alarm messages when system resources a
and set the conditions for sending alarm messages. 

To configure alarms, select Alarm from the Alarm menu in the System Monitor 
window. The Alarm window opens.

Figure 74
System Monitor - Alarm window
P0910103 Standard 1.0 July 2000
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OTM Web Services
OTM provides both Web (http) and Microsoft Windows versions of many
its applications. This chapter discusses the Web versions of those 
applications:

• OTM Web Navigator

• Customizable Web Help

• User Access and Session Monitor pages

• Web Virtual Terminal Service

• Web System Terminal

• Desktop Services (an end-user application which provides web page
that display the configuration of the user’s telephone as well as prov
telephone troubleshooting and feature information)
OTM Common Services User Guide
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OTM Web Navigator
The OTM Web Navigator provides the following:

• A list of systems and devices; users click on a system or device to:

open a Web System Terminal or URL to manage system or device

open Maintenance Pages for performing maintenance operations on
hardware

• Web-based alarm browser to view alarms and events from multiple 
systems and devices

• The ability to locate Meridian telephones and view configuration dat

• Web-based Maintenance Pages to perform maintenance operations
(enable, disable, etc.) on Meridian 1 hardware. Provides a subset of
Maintenance Windows functionality.

• OTM Web configuration pages (login access, LDAP sync reports, et

The OTM administrator has the responsibility of installing, configuring, a
maintaining OTM Web Services. 

User Login and Security
The user logs into the OTM Web Navigator using their Microsoft Window
NT userID and password. Login security for OTM Web Services ensure
protection against unauthorized entry and enforces access privileges for
logged on users.

There are three categories of users:

• OTM administrator

• OTM technicians

• OTM Desktop Services end users

OTM administrators and technicians have user accounts in a Windows N
domain. Desktop Services end users may have accounts either in a Win
NT domain or through an LDAP server.
P0910103 Standard 1.0 July 2000



 OTM Web Services Page 211 of 292

tor 
may 

y 
s and 

the 
ss 
or 
or 

eck 
 

hen 
OTM Web application access privileges are controlled by the Administra
on a per-Windows NT user group basis. For example, the administrator 
limit the OTM users access to only some of the OTM Web-based 
functionality. The OTM Web Navigator controls access to applications b
shielding Web links that the user does not have access to. The directorie
files comprising those applications are similarly protected.

The administrator configures Windows NT user groups and users using 
Windows NT user interface. The administrator then determines the acce
privileges for each user group by using the OTM Web Navigator page. F
more information about setting user access, refer to “OTM Web Navigat
Access” on page 232.

When the user first points a browser to the OTM Navigator Web site, a ch
is performed to see if the user has the required OTM Java plug-in. If the
plug-in is not installed, the user is given the option of downloading and 
installing the plug-in. This operation is similar to the standard download 
operations in that the user must download the plug-in to their hard disk t
install it onto their machine.

While the plug-in check is being performed, the OTM splash screen is 
displayed. If the plug-in is installed, then the user is taken to the OTM 
Navigator login page.
OTM Common Services User Guide
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Figure 75 shows the OTM login page. If the login is successful, the OTM
Web Navigator page appears. If login is denied, an error message appe

OTM Status page
As shown in Figure 76, when the administrator logs in, the OTM status p
appears. You can access this page at anytime by clicking on the “OTM 
graphic” on the top of the tree or the Home button. The OTM Status Rep
contains:

• Last Login date

• Alarm Notification and DBA status

• LDAP sync failures

Figure 75
OTM Navigator Administrator login page
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• Number of logged in users

OTM System Navigator Page
The System Navigator page contains a list of systems defined in the OT
Windows Navigator. You can click on the system and select an applicati
on the right. The list of  applications depends on the system.

For Meridian 1:

• Web-based Virtual System Terminal connection to the overlays with
help

Figure 76
OTM Administrator Status page
OTM Common Services User Guide
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• Web-based Maintenance Pages

• Alarms for the selected Meridian 1 (this opens the Systems Alarms p
with only the selected M1 alarms displayed)

For Generic Systems:

• Web-based Telnet connection

• Management URL for the system

• Alarms for the selected system (this opens the Systems Alarms page
only the selected system alarms displayed)

The list of applications is determined by the OTM System Properties in t
OTM Windows Navigator and the Virtual Terminal Setup. See “OTM We
Virtual Terminal Service” on page 235.

Figure 77
OTM Administrator System Navigator page
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OTM Alarm browser page
The Alarm browser page contains a list of alarms received by the Alarm
Manager Service running on the OTM Server. The list contain alarms an
events from multiple systems and devices. You can perform the followin
actions:

• sort the alarms by clicking on a column header
• resize the columns
• filter the list via the Show checkboxes
• page through the list via the First/Last/Next/Previous buttons
• double click on an alarm for help

For more information on Alarm Management, see the “OTM Alarm 
Management User Guide”. 

Figure 78
OTM Administrator Alarm browser page
OTM Common Services User Guide
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OTM Maintenance Pages
Maintenance Pages are based on existing Maintenance Windows. You c
use them to perform maintenance operations on Meridian 1 hardware. A
subset of Maintenance Windows capability is provided in OTM Maintenan
Pages.

Figure 79
Maintenance Pages
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Find Telephones page
The Find Telephones page allows you to search for telephones in the O
station database. Select a system, and enter the desired search criteria.
search returns a list of telephones.

• The drop down list of systems contains all Meridian 1 systems 
supported by this web site. The list items contains both the site 
systems names as defined in the OTM Windows Navigator. 

• The station database search only retrieves Prime DNs.
• The default search is by Last Name.

Figure 80
OTM Administrator Find Telephones search page
OTM Common Services User Guide
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Find Results page
The Find Results page displays the list of telephones matching the sear
parameters.

• By clicking on the Location link, you open up a new browser window;
which displays the Telephone pages for the telephone set. These ar
same pages that appear when a desktop user displays his telephone
Desktop Services (see “Desktop Services” on page 247). Using the W
browser, however, you can access the Maintenance Help page for t
telephone set by clicking on Troubleshoot Problems.

• Above the results the following is displayed:

— number of items found and the number of the currently displaye
items

— sort drop down list

• You can sort on any field via the “Sorted by” drop down list. When yo
select a new sort, the results is display starting at the first page.

• Clicking on Find Again takes you back to the find page.

• If there are no telephones matching the search parameters, a “Foun
None” message appears with a Find Again button (that takes you bac
the Find page).

Directory Global Change page
This page is used to perform global change on the following OTM Directo
fields:

• Desktop User Group

• Login Name

These fields are required for access to the Desktop Services web pages
Desktop User Group field can be administrator, end user, or blank. If the U
Group is blank, then the user does not have access to the Desktop Serv
Administrator or end user determine the telephone features the user can
as defined in the Desktop User Groups page (see page 223).
P0910103 Standard 1.0 July 2000
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The login name is the user’s Windows NT login name. When the user log
to the Desktop Services web pages, OTM validates the log in with Windo
NT. If login is successful, OTM looks up the user’s Desktop User Group fi
in the OTM Directory to determine which telephone features to display.

Figure 82 illustrates the Directory Global Change page used to select the 
to change and find the directory entries to change. Figure 83 illustrates t
page used to set the new value and then select the entries to change.

Note: For the Organization field, enter the complete organization path fro
the Organization Hierarchy. 

Figure 81
OTM Administrator Find Telephones results page
OTM Common Services User Guide
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The LDAP sync Report page initially shows a list of the existing LDAP Sy
Reports (sync of employee data between the OTM Directory Service and
customer’s LDAP Sever). Clicks on a report to view it. Figure 84 shows 
report format.

Figure 82
Directory Global Change - find entries
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Figure 83
Directory Global Change - set value
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Figure 84
OTM Administrator LDAP sync report page
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Desktop user groups page
The Desktop User Groups page determines which features are available
the telephone Feature page.

• The list contains all the non-key features listed alphabetically by
prompt in LD10 & 11. Each feature is assigned a restriction of 
Hidden or Read Only. If Hidden, the feature does not appear in 
end user Feature drop down list. 

• There are two templates: Administrator and End User. The 
Administrator template is used when you view the telephone 
through the Web Navigator Find Telephone pages. The End Us
template is used when you log on to the end user web site.

• The Show restrictions drop down list contains: All,  Hidden, and 
Read Only. This is used to limit the size of the list.

• Submit and Reset buttons appear at the bottom of the list.

Figure 85
OTM Administrator Desktop user groups page
OTM Common Services User Guide
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Customizable Web Help 
The Custom Help page allows you to customize help text for OTM 
Web-based applications. Typically, you will only customize help that is fo
end users. 

All Web-based help files can be customized. You can either:

• replaced them with customized help provided by you (the administrat
or 

• annotate the help files

The custom help page provides a list of all Web-based help files. You can
a custom help file instead of the standard help by copying and then editi
and/or annotating the standard help.

OTM includes sample HTML files that you can use to create customized h
for the end user. Sample help files are provided for the following help scr
topics: 

• dialing plans

• system speed call lists

• flexible feature codes

Nortel Networks uses a PC-based application, RoboHelp, to generate 
Web-based help files. RoboHelp is also used to generate OTM/MAT 
Windows-based help. RoboHelp generates individual help pages, a table
contents, and index files. Each individual help page has Content and Ind
buttons to return you to the Help table of contents or index. Next and Prev
buttons allow you to navigate to the next help for topic. A Java applet sho
the table of contents and index as navigation frames. Versions of the tab
contents and index are also available without frames. Customizable We
Help will work with the help system provided with RoboHelp.

Customizing Standard Help Files
The following figures show how to access, customize or annotate the he
files. Click on the Customized Help item and tree to access the help file 
want to customize. One example is shown in the following figure. All pag
appear in the Content frame of the Web Navigator.
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Selecting the standard OTM Help files - Help Groups
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Figure 88 shows the help files for the selected help group and subgroup
customize a help file, click the help topic on the left, then click the Copy 
button. This copies the file to a custom help folder. Then click the View, 
Annotate, or Delete buttons. When you do not enable the custom help file
standard help file appears.

Figure 87
Selecting the standard OTM Help files - Help subgroups
P0910103 Standard 1.0 July 2000
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Figure 88
Customizing standard Help files
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Click on the Help file name to display the shipped help. Click on the cust
help file View button to display a two frame window with the location of th
custom help file and the help file contents.

You can only annotate a customized help file. To annotate the file, click 
the “Annotate” button. The Edit Annotation window opens (Figure 89). 
Figure 90 shows the annotation for a help topic. When you submit the 
annotation, the help file includes a paper clip graphic that opens the 
annotation.

Figure 89
Annotating custom Help files
P0910103 Standard 1.0 July 2000



 OTM Web Services Page 229 of 292
Figure 90
Viewing an Annotated Help file
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Figure 91 shows the Web-based help file for overlay 02.

Figure 91
Sample Web-based Help screen
P0910103 Standard 1.0 July 2000
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User Access and Session Monitor
Desktop User Access

The Desktop User Access page allows you to select the method of user 
authentication. The options are:

• LDAP Server

Note: User login identification is required for LDAP.  The drop down
menu only contains employee ID (UID) and email.

• Windows NT Domain. 
OTM Common Services User Guide
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Note: The edit box for the Windows NT domain name is required fo
Windows NT authentication.

For information on configuring users for desktop access, see “Enable we
desktop end user access” on page 149.

OTM Web Navigator Access
The OTM Web Navigator Access page determines which OTM Web 
Navigator pages are available to users. You can create user groups usin
Windows NT Server user interface. Select the user group from the drop d
and then check the pages visible to users in that group. The list of pages 
same as the items in the OTM Web Navigator tree.

Note: The Save button only submits the changes on the selected Us
Group.

Figure 92
OTM Administrator Desktop User Access screen
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Figure 93
OTM Administrator Web Navigator Access screen
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Session Monitor
Login security prevents the web pages from being accessed without firs
successfully providing a valid username and password combination. The
Session Monitor page contains a list of logged in users with the login time
IP address.

Figure 94
OTM Administrator Session Monitor screen
P0910103 Standard 1.0 July 2000
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OTM Web Virtual Terminal Service
The OTM Web Virtual Terminal Service provides a single point of 
connectivity for a Web-based terminal window. Launch the OTM Web 
Navigator from Internet Explorer or Netscape Navigator, and select the 
system to connect to from the GUI. This does not require knowledge of s
items as IP addresses and serial port settings because the information is 
on the server. You determine who gets access to what, and you can cha
the settings without interrupting everyday operation.

The OTM server connects to devices over IP network and serial ports on
OTM server. In 1.0, virtual terminal supports connection primarily to an M
via:

• Meridian 1 PTY port

• Direct serial connection

• Telnet

Support for modem dial-up and VT220 may be added in a future release
OTM Common Services User Guide
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OTM Web System Terminal
The OTM Web System Terminal resembles the OTM Windows System 
Terminal application. When you connect to a Meridian 1 it provides simil
context sensitive help for the overlays and error messages. When you con
to other devices it provides a basic Telnet connection. The OTM Web Sys
Terminal is a Java applet embedded in an HTML page.Once connected t
Terminal Server, the OTM Web System Terminal communicates with th
selected device through the Terminal Server. Only the first client that 
connects to a port can send character input to the host. 

The OTM Web System Terminal displays most messages in a window. 
However, some messages that do not require immediate attention, appe
between the < > characters in the terminal screen. See Figure 95. These
messages are not sent to the host device or logged on the server. The me
can be:

• Status of this client (connected, disconnected, read-only connection,

• Status of other client (monitoring this port, disconnected)

• Broadcast message (received from another client, sent to another cl
P0910103 Standard 1.0 July 2000
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Figure 95
Terminal Client showing messages
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OTM Web System Terminal Menus
The OTM Web System Terminal window has the following menu items:

File menu

• Connect - Connect to a virtual port. This item appears when the clien
not connected to a port.

Note: For a non-administrator user, if a port is already in use by 
someone else, then the connection is not allowed.
If you have administrator privilege, you may connect to a port already
use by someone else. However, you may only monitor the session, 
cannot send text to the host.

• Disconnect - Disconnect from a virtual port. This item appears when 
client is connected to a port.

• Disconnect Others - Disconnect all other clients from a virtual port. T
item appears only for a user with administrator privilege. 

Note: If you select Terminal->Disconnect Others, then all other clien
to the virtual port are disconnected, and you are then allowed to send
to the host.

• Send Message - Display a Send Message dialog. This allows you to
"broadcast" a message to all other users on the same virtual port.

Figure 96
Send Message dialog box
P0910103 Standard 1.0 July 2000
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• Parse M1 Output - This menu has a checkmark to enable parsing of
overlay interaction to provide the context sensitive help. To reduce so
unnecessary CPU overhead, you should uncheck this menu item fo
non-M1 device. If it is checked, then the Help->Current Overlay and
Help->Current Prompt menu items become visible to provide 
context-sensitive help for the M1 overlays.

Edit Menu

• Copy - Copy the selected text to the clipboard.

• Select All - Select all text in the output window.

View Menu

• Look & Feel - cascading menu determines the look of and feel of the u
interface. You can choose:
   Java
   Windows
   Motif

• Overlay Passthru Mode - Make the applet behave like the MAT Syst
Terminal application. It provides a separate edit box to enter comman
which allows for backspace while working in the M1 overlay 
environment.

Note: If this menu item is checked, then the Help->Search M1 Help 
Files menu item becomes visible. If this menu item is unchecked, the
behaves like a standard terminal window.

Help Menu

• Current Overlay - Display help for the current overlay in a separate 
browser window. The OTM Web System Terminal monitors characte
I/O to keep track of the overlay information.

• Current Prompt - Display help for the current overlay prompt in a 
separate browser window. The OTM Web System Terminal monitor
character I/O to keep track of the overlay information.

• I/O Navigator - Display the Overlay Enhancer dialog. This allows you
search for help on an overlay, overlay prompt, or M1 message.
OTM Common Services User Guide
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Note: Like the MAT and OTM System Terminal, the OTM Web System
Terminal has context-sensitive help. It monitors M1 input and output
determine the current overlay and prompt. You can also search for h
for an overlay (“LD22”, for example), overlay prompt (“LD22 REQ”, fo
example), or M1 message (“AMH0007”, for example). You can eithe
select text from the terminal screen and then select Help->Search, o
select Help->Search and then type in the string to search for. 

Terminal Server Setup
The Terminal Server application is a Windows application that uses the O
database to obtain site, system, and IP address information. In the first 
release, the Terminal Server supports direct serial connections and M1 
overlay connection over an IP network. If you connect over an IP networ
a Meridian 1 you can customize the M1 port user types (SCH, MTC, BU
TRF).

The terminal server is launched when the PC starts. Access it by double
clicking an icon in the Task Bar Tray.

Figure 97
I/O Navigator Overlay Enhancer dialog box
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The Terminal Server window displays two lists:

• configured systems

• configured ports

The configured systems list displays information on the virtual port that i
configured:

• Name:
As defined in the OTM Windows Navigator

• Number of clients:
The number of terminal clients using the port

When you select an entry in the Configured Ports list, the Clients on Port
displays the following information for each terminal client using the port:

Figure 98
Terminal Server Window
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• From:
IP address of the terminal client

• Duration:
How long the connection has been in use

The Disconnect button next to the Clients on Port list allows you to termin
the connection to one or more terminal clients.

The Terminal Server application also has the following buttons:

• Exit - Terminate all existing client connections and exit the applicatio
While the application is not running, a terminal client cannot connect
a host.

• Hide - Hide the application window. During normal operation, the 
Terminal Server application runs without user input, so hiding its 
window frees up some desktop space. You can view the window at 
time by double clicking the Terminal Service icon in the Task Bar tra

• Systems - Configure the virtual ports. See Virtual ports below.

• Terminals - Configure the starting network socket port number for 
communications between the OTM Server and the OTM Web Syste
Terminal. The default is 4789. Typically you will not need to change th

• Help - Get context-sensitive help on the application.

Figure 99
Terminal Properties dialog box
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Virtual Ports
In the Terminal Server application, the Virtual Ports Properties window 
allows you to enable or disable connection to a particular device. It displ
the virtual port number for each configured device, and the correspondin
serial or network settings.

In the Virtual Port Properties window, a tree displays the devices that ca
connected via a virtual port. For serial ports, the window retrieves the 
available serial ports from the Registry. For network connections, the wind
retrieves the site and system information from the OTM database. The vir
port for a system uses the same IP address assigned to System Termina
tree mirrors the tree in the OTM Navigator. It uses the communication pro
in System Properties, determined as follows:

• For a Generic system, it uses the profile  (serial or network) selected
the Application page in System Properties. 

• For a non-Generic system, it uses the communication settings from 
profile (serial or network) assigned to VT220 in the Applications page
System Properties.

• For a non-M1 system, if a network (Ethernet) profile is selected, 
Terminal Server uses a Telnet connection.

To configure virtual port connection for a device click the Systems button
Terminal Server window, or double-click a Configured System in the list (t
selects the corresponding device in the Virtual Port Properties window 
allowing you to quickly change the settings for a particular device).

To enable virtual port connection for a device:

• Double-click the disabled port in the tree, or

• Select the item and check the Enabled checkbox., or

• Click the Enable All button. This enables all the items listed in the tre
with the default configuration. The item becomes bold to show that i
enabled.

The field to the right of the Enabled checkbox automatically fills in the Sit
System name for the selected device. This is the name displayed in the 
Terminal Server's main window.
OTM Common Services User Guide
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To disable a virtual port:

1 Double-click an enabled item in the tree, or
Select the item and uncheck the Enabled checkbox, or

2 Click the Disable All  button. This disables all the devices listed in the 
tree. The item is no longer bold, and does not appear from the 
Terminal Server main window when you click OK.

Serial Connections
The Terminal Server application supports all the serial ports on the OTM
server PC plus the systems configured in the OTM Navigator. However,
while more than 8 serial ports may be configured, the Terminal Server is
limited to 8 simultaneous serial connections. (The limit depends on the O
server hardware, the network capacity, the server's CPU capacity, etc.)

For a serial connection, Direct to Com x appears, where x is the comm p
number. The fields for serial settings are enabled. The default is the seri
settings from the OTM database. You can change the settings in the dia
box.

Network Connections
For a network connection, the IP address appears. It also appears wheth
system is an M1 or Telnet.

• Make sure the IP address is correct. If the IP address is different from
OTM database's setting, click the Refresh button to update the all 
network ports with the latest settings from the OTM database.

• If you select an M1 System, the fields for M1 port settings are enabl
(default = SCH). The Telnet port field is disabled.

• If you select a non-M1 System, the fields for both serial and M1 port
settings are disabled. The Telnet port field is enabled.

• Check the Log checkbox to turn on data capture. The log file name 
defaults to the Site - System name plus a .txt extension. The path an
file name can be changed by typing in the edit box or clicking the Cha
button.
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• The maximum size of the log file is customizable (in the Size field) on
per-system basis, and defaults to 256K. Once the file size reaches t
limit, the Terminal Server starts from the beginning of the file, 
overwriting the oldest logs.

• Because of the circular nature of the log, the Terminal Server writes
end-of-file marker (customizable in the Marker field) at the end of the l
entries.

Figure 100
Virtual Port Properties (Serial with Logging enabled)
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• The log records the time and date of when a client connects and 
disconnects to the virtual port, and writes all text received from and s
to the host. This allows a network administrator to keep an activity log
the virtual port connection.

• If this ASCII log is to be viewed from a web browser, the file should b
stored in a web-accessible path.

Figure 101
Virtual Port Properties (Network with Logging disabled)
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Desktop Services
OTM Web Desktop Services allows end users to view the configuration 
their telephone via a web browser.

The Web display includes a graphical view of the telephone, and shows
configured features. Help text is available for the features configured on
telephone. You will be able to restrict display of features  (e.g. most Clas
Services are irrelevant for end users).

Login Page
Login security ensures protection against unauthorized entry and enforc
access privileges for logged on users.

When a user points a web browser to the OTM end user URL a login pa
appears. If login is successful, the user’s personal Desktop Service main 
appears.

Figure 102
User Login page
OTM Common Services User Guide
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End User Main Page Layout
The Web Desktop Services end user main page includes the following 
common elements: 

• Information Banner  (top): Contains the Nortel logo, plus a Help, 
Logout, and Home button. The Help button takes you to general help
how to use these web pages. The Home button takes you to the My
Profile page. The logout button takes you to the login page.

• Navigation Bar (left side): Lists hypertext links to various Desktop 
Service pages. When you single click on an item in the Navigation b
the related page appears in the Content Frame of the standard Web

• Note: In the rare situations where a user has telephones on differen
switches managed by the OTM Server, the Navigation Tree expand
include the systems as the main nodes. The user selects the My Prof
Telephone(s) in the desired system.

• Content Frame:  Contains the page based on the selection in the 
Navigation bar. There are three types of pages:

Home page - general information about the user (name, department, 
The information displayed is determined by the administrator.

Telephone pages - contains telephone configuration data. User may 
more that one telephone. The information displayed is determined by
administrator.

Other Links - contains links provided by the administrator.

A line is placed at the bottom of each content page to visually indicate the
of the page. If vertical or horizontal scrolling is required, the entire page 
scrolled.
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Home Page
Once logged in, a page appears containing general information about the
The system retrieves this information from the OTM Directory. Click the 
Home button in the Banner or My Profile in the Navigation bar to take you
this page.

The information that appears is fixed and cannot be configured. If there i
information for a field, it is left blank. 

• Employee first, middle, and last name
• Identification (employee ID)
• Job Title
• Org Path (this is extracted from the Organization Path in the OT

directory).
• Manager
• Email address

Figure 103
Home page
OTM Common Services User Guide
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Telephone Pages
Once logged in, the user is presented with a list of telephones in the 
Navigation Bar. The telephones are identified by its prime DN. In order to 
this list, the Web Server scans all the employee databases (one per 
Meridian 1) on the Server.  If the employee has telephones in different 
systems, served by different OTM servers, then the employee will have to
in to the different servers.

When a user clicks on a telephone in the Navigation Bar, the telephone p
appears in the Content Frame.

The telephone page has a small graphic in the top left corner. This graph
detailed enough for the user to recognize the type of telephone. The use
name and the prime DN of the telephone also appear.

The telephone has up to four sub-pages, accessed by links below the sm
telephone graphic. The capabilities provided by these web pages depen
the telephone type.

Telephone General Page
The General Page provides general information about the telephone. Th
information that appears is fixed and you cannot configure it.

• Station Location - a text field similar in purpose to the System field. 
You may want to use this to provide more user friendly names.

• Phone type (M2317, M2616, etc.)

• Terminal Number  (TN): Address of the telephone

• System - identifies the site, system, and customer number where the
phone is connected. This information is retrieved from OTM commo
services. Displayed in the format “Site - System - Customer x”.

• Add-on Key Modules

• Designation - a unique 1-8 character telephone identifier. This data i
stored in  station data and the overlays. Often used to identify the loca
of the phone within the building (for example, cable pair). Prompts D
in LD 10/11.

• A link is provided to a trouble shooting page. See page 252.
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Figure 104
Telephone General page
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Telephone Trouble Shooting page
You can access the Telephone Troubleshooting page from the General 
via a link. The Reset button performs an enable and status command on
telephone via a Maintenance Windows API.

Figure 105
Telephone Troubleshooting page
P0910103 Standard 1.0 July 2000
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Telephone Keys Page
The Telephone Keys page displays a graphical layout of the function ke
assigned to the telephone. The layout varies for different telephone type

All current feature key assignments will always be visible. The key labels
the graphic match the labels in Station Administration. For 3900 series 
telephones these match the soft labels on the set and the text is shortene
characters. When the page first appears, key 0 is selected. You can sele
other keys by clicking on a key.

When a key is selected the following occurs:

• The key is highlighted (method depends on phone type).

• The name of the key and its configurable parameters (if any) are 
displayed beside the telephone graphic.

If the telephone has Add-On Key Modules, a graphic indicates which se
keys is displayed. You can "scroll" the graphic from one set of keys to 
another. 

A Help button takes you to help on how to use the selected key.
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Figure 107 shows the UI for Add on Key modules on an M2616 telephon
Click the next/prev links to navigate between the banks of keys.

Figure 106
Telephone keys page
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Figure 107
Telephone Keys page with Add on Keys
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Telephone Features page
The Telephone Features page allows you to view and change features th
not assigned to keys. Features are related to individual prompts in LD 10
11, with one or more configurable parameters.

The drop down list contains the list of features. When you select a feature
appropriate information appears. The Help button takes you to help on h
to configure that feature group.

The administrator determines which features the user can see in the dro
down list.

Telephone Details page
The Telephone Details page provides a summary of  the complete telep

Figure 108
Telephone Features page
P0910103 Standard 1.0 July 2000



 OTM Web Services Page 257 of 292

t 
e 
configuration. It consists of two tables, one for the keys and one for the 
features. 

Other Links
You can define the Other Links button of the Navigation bar. If you do no
define links, then this section is not visible. To define Other Links edit th
HTML file as shown in Figure 111. The file is located in: 
“<Nortel>\OMServices\OMStation\EndUser\Eng”

Figure 109
Telephone Details layout (page 1)
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Meridian Mail
One possible item which could go into the Other Links section is a link to
Personal Mailbox Administration (PMA). This link takes the user to the UR
for logging into the Meridian Mail web pages. The user must enter the 
mailbox number and password to proceed. Once logged in, the user can 
and change their mailbox configuration. This feature is available with 
Meridian Mail 13 and later releases.

Figure 110
Telephone Details layout (page 2)
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Figure 111
Other Links
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Meridian Mail Login
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Data Bufferin g and Access
The OTM Data Buffering and Access (DBA) and M1 Database Disaster 
Recovery applications provide a Windows interface to start a live data 
buffering session and define the session properties for collecting data fro
Meridian 1. A network or PPP connection allows collection of CDR and 
Traffic data. A serial connection allows collection of ASCII data only.

With a PPP or network connection, you can perform the following tasks:

• Schedule a single or routine backup of your Meridian 1 data base fil
On an Option 11C system, schedule the retrieval of buffered CDR a
Traffic data from the Meridian 1 to the PC.

• View collected CDR and Traffic data.

• Backup and restore a Meridian 1 data base to and from a remote de
for data base recovery.

If you lose a connection or have connection problems during a live data 
session, the Meridian 1 saves the CDR and Traffic data. You can retrieve
data when the connection is restored.

With a serial connection, you can perform the following tasks:

• Set up the actions and rules for generating alarms. 

Note: A serial connection does not support the DBA Backup and 
Restore functions.

• View collected serial data.

If you lose a connection or have connection problems during a live serial 
session, data will be lost.
OTM Common Services User Guide
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Use the DBA application to schedule the following tasks:

• Archive CDR and Traffic from the M1.

• Perform M1 Database Disaster Recovery (back up only).

Access DBA
To access DBA, select Data Buffering and Access from the Utilities menu in the 
OTM Navigator window.

The DBA main window appears. (See Figure 113.)

DBA menus
Descriptions of each command in the DBA menus are available online. U
the Help command to get detailed descriptions of the commands. 

Figure 113
DBA Main window
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DBA Toolbar
The DBA Toolbar provides easy access to many of the menu command

Right-click the mouse in the session window to view the pop up menu 
containing a subset of the menu items.

Start a new live data session
To collect live data, you must start and configure a live data session (an a
connection to a Meridian 1 system). The DBA application runs continuou
during the session, providing access for session configuration and a win
for monitoring session information. Special operations, such as Meridian
data base backup, can be run immediately or scheduled to run within a 
session.

Note: To maintain a live data session, you must keep the DBA main
window open continuously. To minimize screen congestion, hide the
DBA main window to remove it from the Windows Desktop. See “Hid
and restore the DBA main window” on page 281.

1 Select New Session from the File menu in the DBA main window.

The Select an M1 System for Live Data dialog box opens. (See Figure 1

Figure 114
Select an M1 System for Live Data dialog box
OTM Common Services User Guide
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2 Select the M1 system for the session from the tree and click OK , or 
double-click the selected system.

The Session Properties dialog box opens. (See Figure 115.) 

Define session properties for a network connection
Session properties for a network connection are defined as follows: 

1 (Required) The name of the selected M1 system appears in the Host Name 
box.

Note: To change your system selection, click Change to return to the Select 
an M1 System for Live Data dialog box. 

2 (Required) Select network connection in the Connect Using box. 

3 (Required) The IP address for the selected M1 system appears in the IP 
Address box.

Figure 115
Session Properties dialog box
P0910103 Standard 1.0 July 2000



 Data Buffering and Access Page 265 of 292

n 

e 

you 

e 
dow 
ta” 

lose 

g the 

o 
 

4 (Optional) Enter your M1 log in name in the User ID box.

5 (Required) Enter your M1 log in password in the Password box.

Note: The Host Name, IP Address, User ID, and Password data exist for 
the selected Meridian 1 system in OTM Navigator. The DBA application 
automatically fills these fields with values from the OTM data base. Any 
changes made in this dialog box are temporary and lost when the sessio
window closes.

6 Check the Collect boxes to select the types of data (CDR and/or Traffic ) that 
DBA will buffer.

7 Select Connect Now to connect to the selected M1 system and begin a liv
data session.

If you do not buffer all available data types, a dialog box appears asking 
to confirm your selection.

A new window opens within your DBA main window. The host name of th
connected M1 system appears on the title bar. DBA uses this session win
to provide information about the live data session. (See “View session da
on page 278.)

Leave the session window open to maintain the live data session. If you c
the window, the live session terminates. If the session terminates, the 
Meridian 1 system begins sending buffered data to one of the following 
devices, depending on the session parameters you set when establishin
connection:

• Hard drive (large systems). Not recommended for large systems.

• PCMCIA card (Option 11C)

Define session properties for a serial connection
Session properties for a serial connection are defined as follows:

1 (Required) The name of the selected M1 system appears in the Host Name 
box.

Note: To change your system selection, click Change to return to the Select 
an M1 System for Live Data dialog box. 

2 (Required) Select serial port connection in the Connect Using box. 

Note: If you select a serial connection, use the Rules Manager window t
define the actions taken when a specific data pattern appears in the data
stream. See “Configure Actions and Rules” on page 266.
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3 Select the data rate for the connection in the Data Rate box.

4 Select the data bit setting for the connection in the Data Bits box.

5 Select the parity setting for the connection in the Parity  box.

6 Select the stop bits for the connection in the Stop Bits box.

7 Enter the name of the file to store data collected from the serial port in the File 
Name box. The file exists under the selected site and system. Enter a new
name or select one of the following files from the drop down list. 

• detail1.img - File used for CDR data.

• traffic.dmp - File used for Traffic data.

8 Rule File is a read only field containing the name of the rules file for this 
DBA session. Edit the field with the Clear and Configure buttons.

• Clear - Removes the file name from the Rule File field

• Configure - Opens the Rules Manager window shown in Figure 11
You can create a new rules file or open and edit an existing rules f
If you create a new rules file, you must define the actions taken wh
a specific data pattern appears in the data stream. See “Configur
Actions and Rules” on page 266.

Confi gure Actions and Rules
Actions and rules are configured for serial connections. The Rules Mana
window allows you to:

• Define the file you want to save or load into the Rules Manager

• Configure new actions or update or delete existing actions

• Configure new rules or update or delete rules, and set the order fo
applying rules.
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Figure 116
Rules Manager—General tab
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Define the Rules Configurations file
Use The General tab to select the rules configuration file you want to save
load into the Rules Manager. See Figure 116.

1 The File Name box is a read only field displaying the path and file name o
the current rules configuration file. To use a different rules configuration fi
click on one of the following buttons:

• New - Resets the Rules Manager dialog box to blank. If changes h
been made to the current configuration, you are prompted to save
changes.

• Open - Opens the standard file dialog box, which allows you to sele
a rules configuration file. If you change the current configuration,
you are prompted to save the changes.

• Save As - Opens the standard file dialog box allowing you to save 
existing rules configurations file under another file name. Enter th
new name and click the Save button. The Rules Manager window
appears with the name of the file in the File Name box.

2 After you define the configurations file, use one of the following buttons:

• OK  - Saves the rules configuration file and closes the Rules Mana
window.

• Cancel - Discards any changes to the rules configuration file and
closes the Rules Manager window.

• Apply  - Saves the rules configuration file. The file remains open i
the Rules Manager window, allowing you to make changes to the 

• Help - Displays online help.

Configured Actions
Use the Actions tab to define new actions or update or delete existing act
See Figure 117.

1 Select an action from the displayed list and click one of the following butto

• Add - Opens the New Action dialog box shown in Figure 118. Se
“Define a New Action” on page 270.

• Edit  - Opens the dialog box to edit configurations for the selected
action. 

• Delete - Select the action and click the Delete button to delete the
action.
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2 After you define the actions, use one of the following buttons:

• OK  - Saves the actions in the configuration file and close the Ru
Manager window.

• Cancel - Discards any changes to the actions and closes the Rul
Manager window.

• Apply  - Saves the actions in the configuration file. The file remain
open in the Rules Manager window, allowing you to make chang
to the file.

Figure 117
Rules Manager—Actions Tab
OTM Common Services User Guide
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Define a New Action
The New Action dialog box shown in Figure 118 provides a list of 
configurations you can apply to the selected action. You can configure th
SNMP trap and Write to File actions. Based on the configuration you sel
another dialog box such as, SNMP Trap, displays for you to define the 
configuration for the action.

SNMP Trap dialog box
The SNMP Trap dialog box shown in Figure 119 defines the destination 
the SNMP Trap action. Select the radio button for the destination of the t
The valid selections are a local IP address or a user defined address. Th
destination address must be running an application capable of taking the
SNMP trap sent from DBA. When you select a local IP address (the defa
sends all traps to the same system running DBA and the Trap Server.

The local IP address does not exist in the Rules Manager configurations
You can change the local IP address without resetting the value in the def
action in the configuration file.

Figure 118
New Action dialog box
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Write to File dialog box

The Write to File dialog box shown in Figure 120 allows you to define th
destination for a Write to File action. Enter a name for the action and the n
of the file for storing the action. The file is in the OTM Common Data 
Directory in the system level folder. Because the file exists in the commo
data directory, multiple sessions defined for different sites and systems 
use the same Rules Manager file. You can copy the file to another OTM
system. 

Figure 119
SNMP Trap dialog box

Figure 120
Write to File dialog box
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Configure Rules
Use the Rules tab to define new rules, update or delete rules, and set the
for applying rules to the data stream. See Figure 121.

1 Select an event from the displayed list and click one of the following butto

• Up or Down - Moves the selected event up or down one position 
the list.

• Add - Opens the New Rule dialog box shown in Figure 122. See 
“Define a New Rule” on page 273.

Figure 121
Rules Manager—Rules Tab
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• Edit  - Opens the dialog box to change the selected rule. 

• Delete - Select the event and click the Delete button to delete the r

2 After you define the rules, use one of the following buttons:

• OK  - Saves the rules in the configuration file and close the Rules
Manager window.

• Cancel - Discards any changes to the rules and closes the Rules
Manager window.

• Apply  - Saves the rules in the configuration file. The file remains 
open in the Rules Manager window, allowing you to make chang
to the file.

Define a New Rule
The New Rule dialog box shown in Figure 122 provides a list of the types
rules you can define. You can configure the rules for an M1 Alarm, Merid
Mail Alarm, or a generic event. For example, an M1 Alarm rule can match
M1 alarm code. A match records the data provided with the alarm. A rule
a generic event is for a system other than those listed.

Figure 122
New Rule dialog box
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M1 Alarm dialog box
The M1 Alarm dialog box shown in Figure 123 defines the values for an M
Alarm rule.

The Event edit box defines the text that will be used to determine if a mat
is found in the data stream. The Event field excepts regular expressions for 
performing complex text comparisons.  The menu button beside the field
provides a list of regular expression options.  See Regular Expression M
Button for more details.

The Severity field contains a list of predefined severity values. The values
provided are Info, Warning, Minor, Major, Critical and Clear.  The defaul
value is Info.

The Action Name field contains a list of actions by action name.  This list 
dynamically created using the actions defined on the Actions page of the
Configuration Property Sheet.  The default value is blank meaning no ac
will occur if an event match occurs.

Figure 123
M1 Alarm dialog box
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Meridian Mail Alarm dialog box
The Meridian Mail Alarm dialog box shown in Figure 123 defines the valu
for a Meridian Mail Alarm rule. The Severity Level field contains a list of 
predefined severity levels.  The values provided  are Information (INF), 
Minor (*), Major (**), Critical (***), Clear (OFF) and All.  This allows the 
user to define the Meridian Mail severity level in the data stream, which 
used in addition to the Event, to determine if a match is found. The optio
chose All for severity level was added to allow the user to match the eve
regardless of the severity level sent from Meridian Mail. 

The Event field defines the text that will be used to determine if a match i
found in the data stream. The Event field excepts regular expressions for 
performing complex text comparisons.  The menu button beside the field
provides a list of regular expression options.  See Regular Expression M
Button for more details.

The Severity field contains a list of predefined severity values. The values
provided are Info, Warning, Minor, Major, Critical and Clear.  The defaul
value is Info.

The Action Name field contains a list of actions by action name.  This list 
dynamically created using the actions defined on the Actions page of the
Configuration Property Sheet.  The default value is blank meaning no ac
will occur if an event match occurs.

Figure 124
Meridian Mail Alarm dialog box
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Generic Event dialog box
The Generic Event dialog box in Figure 125 allows you to define the valu
for a generic event rule. Generic systems are not Meridian 1 systems.

The Event edit box defines the text that will be used to determine if a mat
is found in the data stream. The Event field accepts regular expressions for 
performing complex text comparisons.  The menu button beside the field
provides a list of regular expression options.  See Regular Expression M
Button for more details.

The Number of Lines in Event field defines the number of lines in the da
stream to capture. The values are 1 to 5 (0 is the default). A value of zer
records the event only.

The Severity field contains a list of predefined severity values. The values
provided are Info, Warning, Minor, Major, Critical and Clear.  The defaul
value is Info.

The Action Name field contains a list of actions by action name.  This list 
dynamically created using the actions defined on the Actions page of the
Configuration Property Sheet.  The default value is blank, which means 
no action will occur if an event match occurs. 

Figure 125
Generic Event dialog box
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Schedule a Backu p or Retrieval
DBA allows you to schedule a single or routine backup of your Meridian
data base files. On an Option 11C system, you can schedule the retriev
buffered CDR and Traffic data from the Meridian 1 system to the PC. 

The following procedure describes how to schedule either operation in D

Note: A scheduled job does not configure the M1. Use the correct L
117 settings (DBK and BUF) for the M1.

1 Select Schedule from the File menu in the DBA main window.

The Select an M1 System for Scheduling dialog box opens. 

2 Use the dialog box tree to select the M1 system you want to schedule.

3 Click OK , or double-click on the selected system, to confirm your selecti

The Scheduled Job Properties dialog box opens. (See Figure 126.)

4 To change your system selection, click on Change to return to the last dialog 
box.

Figure 126
Scheduled Job Properties dialog box
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5 (Optional) Enter the Host Name of the System in the indicated field.

Note: The Host Name, IP Address, User ID, and Password data for the 
selected Meridian 1 system are stored in the OTM data base. The DBA 
application automatically fills these fields with the values from the OTM da
base. In the Scheduled Job Properties dialog box, these fields are read-o
If the values are not correct, enter the correct values in the OTM Navigat
System Properties.

6 Click on the check box of the operation you want to schedule:

• M1 Database Backup - back up Meridian 1 data base files.

• Data Retrieval - retrieve buffered CDR and Traffic data from the 
Meridian 1 system.

Note:The Data Retrieval check box only functions for an Option 11C syste

7 Click OK  to confirm your settings.

The Scheduling dialog box opens. See Figure 127. 

8 Schedule the job by completing the items in the Scheduling dialog box a
clicking the OK button.

View session data
In a live session, you can view the collected CDR, Traffic, and serial data,
the session data collection statistics. (See Figure 128)

From the View menu, select one of the following:

• CDR Data to display a snapshot of CDR data collected by DBA (up 
the last 15 minutes).

• TRF Data to display a snapshot of Traffic data collected by DBA (up 
the last 15 minutes).

• Statistics to display the average number of CDRs per minute, the tim
of the last Traffic Sample, and the time of the last serial data 
connection.

• Refresh to update CDR, Traffic, and serial data views with the lates
collected data.
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Figure 127
Scheduling dialog box

Figure 128
Sample session window displaying Statistics
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You can use the following Edit menu commands to handle text in the ses
window.

• Copy to copy text from the session window.

• Select All to select all text in the session window.

• Find to locate selected text in the session window.

M1 Database Disaster Recover y
M1 Database Disaster Recovery provides a quick way to perform a 
Meridian 1 data base backup and restore, or to schedule a data base ba
You can schedule or manually start a backup operation, and the applica
connects to the switch and retrieves the data base files. You can manua
start a restore operation to restore the data base file to the PBX.

Note: M1 Database Disaster Recovery runs separate from the norm
Meridian 1 data base backup feature: Electronic Data Dump (EDD).

1 Open and select a session window.

2 Select M1 Database Disaster Recovery from the File menu.

The M1 Database Disaster Recovery dialog box opens. (See Figure 129

Figure 129
M1 Database Disaster Recovery dialog box
P0910103 Standard 1.0 July 2000



 Data Buffering and Access Page 281 of 292

live 

m 

n 

ot 
 the 

pen 
 to 
ay 

the 
 

3 Click on one of the two radio buttons to select an operation:

• Backup - back up Meridian 1 data base files to the PC.

Note: A backup can be run on a PC that is not the PC used for collecting 
CDR and/or Traffic data.

• Restore - transfer earlier backed up Meridian 1 data base files fro
the PC to the Meridian 1 system.

WARNING: The Restore operation overwrites the existing data base files o
the Meridian 1 system. Before you use the Restore operation:

• Make sure that your back up files are valid.

• Make sure that no other PC is performing a Backup or Restore.

4 Select one of the following buttons:

• Run Now to begin the selected operation

• Schedule to indicate a time for routine data base backup. You cann
schedule a restore. The OTM Scheduling dialog box opens. Use
dialog box to schedule your data base backup. See “Schedule a 
Backup or Retrieval” on page 277.

The DBA application displays the status of the backup or restore.

Hide and restore the DBA main window
To maintain a live data session, you must keep the DBA main window o
continuously. To minimize screen congestion, hide the DBA main window
remove it from the Windows Desktop. DBA remains active and the DBA tr
icon continues to appear on the Windows Toolbar.

To hide the DBA main window do one of the following:

• Select Hide Application from the View menu.

• Click the Hide Main Window button on the toolbar.

• Double-click the DBA tray icon.

To restore your DBA main window, double-click the tray icon.

You can right-click on the tray icon to display a pop up menu containing 
menu items, Hide Window or Restore Window. Use these commands to hide
or restore the DBA main window, or select Exit  to end the program.
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Appendix A: Scri pt File Summar y
This appendix contains a list of all of the script files used for the OTM 
applications. A script is a pre-written program which contains a set of 
commands and functions required to perform specific activities. Some scr
are defined for specific PC and Meridian 1 configurations and are theref
selected based on each user’s configuration. Most OTM scripts, however
defined for the general operation of the OTM applications and are theref
automatically selected to perform specific functions within OTM.

Common Services scri pts
The following script files are used by the OTM Common Services 
applications. They are automatically selected whenever you run OTM an
apply to all of the OTM applications as a whole. You do not need to sele
these script files to perform a required function.

HAYESMDM.SCR Functional script used by Common Services 
applications for connection with Hayes 
compatible modems

CUSTMDM.SCR Functional script used by Common Services 
applications for connection with customized 
modems

M1MODEM.SCR Functional support script used to access 
far-end equipment (e.g., dispatcher modems)

ERROR.SCR Functional script required for error handling
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Telecom Billin g System scri pts
The following script files are used by the Telecom Billing System to perfo
data collection. Select the script file that matches your data collection an
processing requirements.

Real time CDR data collection
The following script files are used for real time CDR data collection from t
Meridian 1; no buffer unit required.

CDR data collection from MDR-2000
The following script file is used for data collection from an MDR-2000 buff
unit.

Sample data collection
The following script file is used to collect CDR data from a sample file. Th
is used for testing purposes.  

SL1OLD.COL Real time data collection script for 
Old format CDR.

SL1NEW.COL Real time data collection script for 
New format CDR.

MDR2000.COL Data collection script which 
collects New format CDR from 
MDR-2000 to produce normalized 
CDR (erases contents of buffer). 
MDR-2000 requires a chip which is
compatible with X11 Release 23.

SAMPLE.COL Data collection script which 
collects sample CDR data from 
sample file in the Telecom Billing 
System directory.
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Traffic Anal ysis scri pts
The script files used by OTM Traffic Analysis provide the main functions
required for traffic data collection and report generation. The data collect
script files are selected when you enter your Meridian 1 and communicati
parameters. The report generation script files are automatically selected w
you generate reports.

Real time traffic data collection
The following script files are used for real time traffic data collection (no 
buffer unit). They will be automatically selected when you set up this site
real time traffic data collection (from the OTM Site Configuration 
application).

Traffic data collection from MDR-2000
The following script files are used for traffic data collection from an 
MDR-2000 buffer unit. They will be automatically selected when you set 
this site for traffic data collection through the MDR-2000 buffer unit (from
the OTM Site Configuration application).

Traffic data collection from PollCat II/III
The following script file is used for traffic data collection from the PollCa
II/III buffer units. It will be automatically selected when you set up this si
for traffic data collection using the PollCat II/III buffer units (from the OTM
Site Configuration application).

LD2.SCR Main traffic data collection scripts

LD2INI.SCR Functional script used by LD2.SCR (used to 
initialize Meridian 1 to have collection 
performed hourly)

LOGSL1.SCR Functional script used by LD2.SCR

M2K.SCR Main traffic data collection script

M2KINI.SCR Functional script used by M2K.SCR (used to 
initialize Meridian 1 to have collection 
performed hourly in pass-through mode)

POLL.SCR Main traffic data collection script
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Traffic data collection from AT1/AT2
The following script files are used for traffic data collection from the AT1 a
AT2 buffer units. They will be automatically selected when you set up th
site for traffic data collection using the AT1 or AT2 buffer units (from the
OTM Site Configuration application).

Traffic data collection from SEB II
The following script file is used for traffic data collection from the SEB II 
buffer unit. It will be automatically selected when you set up this site for 
traffic data collection using the SEB II buffer unit (From the OTM Site 
Configuration application).

Traffic data collection from Sentinel 2000
The following script file is used for traffic data collection from the Sentine
2000 buffer unit. It will be automatically selected when you set up this site
traffic data collection using the Sentinel 2000 buffer unit (from the OTM S
Configuration application).

Traffic Analysis report generation
The following script files are used for report generation. They are 
automatically selected when you generate Traffic Analysis reports.

TSB1.SCR Main traffic data collection script for AT1 
buffer unit

TSB2.SCR Main traffic data collection script for AT2 
buffer unit

SEBTRAF.SCR Main traffic data collection script

SNLTRAF.SCR Main traffic data collection script

AUXPLK.SCR AVGSOA.SCR CALPRK.SCR CBKQUE.SCR

CONSOL.SCR CSAML1.SCR CSAML2.SCR CSAML3.SCR

CSAML4.SCR CSAML5.SCR CSAML6.SCR CSAMLI.SCR

CSAMLK.SCR CUSCON.SCR DCHANL.SCR DTDLAY.SCR

DTNSPD.SCR FEAKEY.SCR GLOBAL.SCR GLPTRF.SCR

GMSGAP.SCR GNTLPS.SCR GOHQUE.SCR GPCLTB.SCR
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The following script files are used for the Data Parser as part of the repo
generation process. They are automatically selected when processing da
Traffic Analysis reports.

Call Trackin g scri pts
The following script files are used by Call Tracking to perform data collecti
and real time monitoring. Certain script files are automatically selected wh
you enter your configuration parameters in the OTM Site Configuration 
application. These represent the common scripts for data collection.

GPROCL.SCR GROUTL.SCR GSUTRF.SCR GTRNKS.SCR

ICONSL.SCR IMTCHL.SCR INPMSG.SCR INTRKG.SCR

ISDNPD.SCR ISDNPM.SCR ISDNPT.SCR JCTRAF.SCR

JCTRGP.SCR LPTRAF.SCR MICRO.SCR MSGATQ.SCR

MUSBRD.SCR NCOSVC.SCR NETLPS.SCR NETWKS.SCR

NTATSV.SCR OHKOVT.SCR OHKQUE.SCR OMTCHL.SCR

OUTMSG.SCR PCTLTB.SCR PRADIO.SCR PROCLD.SCR

RADPAG.SCR RANBRD.SCR RTLREQ.SCR SELTRM.SCR

SLTRAF.SCR SRADIO.SCR SUMCCO.SCR SUMICO.SCR

SUMSYS.SCR SUMTRK.SCR SVCLPS.SCR TMESSG.SCR

TRUNKS.SCR TSETST.SCR WATCON.SCR WPRCLD.SCR

WTRNKS.SCR

TFC000.SCR TFC001.SCR TFC002.SCR TFC003.SCR

TFC004.SCR TFC005.SCR TFC006.SCR TFC007.SCR

TFC008.SCR TFC009.SCR TFC10X.SCR TFC101.SCR

TFC105.SCR TFN001.SCR TFN002.SCR TFN101.SCR

TFS000.SCR TFS001.SCR TFS002.SCR TFS003.SCR

TFS004.SCR TFS005.SCR TFS007.SCR TFS008.SCR

TFS009.SCR TFS010.SCR TFS011.SCR TFS012.SCR

TFS013.SCR TFS50X.SCR TFS101.SCR TFS102.SCR

TFS105.SCR TFS41X.SCR TRAFFIC.SCR TRFAXS.SCR

TRFCDR.SCR TRFCUS.SCR TRFNET.SCR TRFSYS.SCR
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For example, if you define SDI1 to have real time CDR data collection 
performed from it, then SDI1 will be configured to run the real time CDR da
collection scripts SL1.SCR and SL1LOGIN.SCR.

If you collect CDR data from a data file (e.g., if you select the File option
from the Call Tracking Communications data base), then you can select
filename from which you will collect the CDR data and then select a scri
filename for that particular format of CDR data. For example, if you selec
file for data collection which contains normalized CDR data, then you wou
select the script file COLLECT.SCR.

Real time CDR data collection
The following script files are used for real time CDR data collection from t
Meridian 1; no buffer unit is required.

SL1.SCR Real time data collection script for Old format 
CDR

SL1NEW.SCR Real time data collection script for New 
format CDR

SL1NEWX.SCR Real time data collection script for New 
format CDR; supports X11 Release 23

SL1EURO.SCR Real time data collection script for New 
format CDR with Periodic Pulse Metering

SL1EUROX.SCR Real time data collection script for “New” 
format CDR with Periodic Pulse Metering; 
supports X11 Release 23

SL1LOGIN.SCR Functional script used by above-mentioned 
data collection scripts
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CDR data collection from MDR-2000
The following script files are used for data collection from an MDR-2000
buffer unit.

CDR data collection from PollCat II/III
The following script files are used for data collection from the PollCat II/I
buffer units.

CDR data collection from AT1/AT2
The following script files are used for data collection from the AT1 and AT
buffer units.

COLLECT.SCR Data collection script which collects Old 
format CDR from MDR-2000 to produce 
normalized CDR (erases contents of buffer)

COLLECTX.SCR Data collection script which collects New 
format CDR from MDR-2000 to produce 
normalized CDR (erases contents of buffer); 
MDR-2000 requires a chip which is 
compatible with X11 Release 23

2000FD.SCR Data collection script which monitors in real 
time Old format CDR from an MDR-2000

2000FDX.SCR Data collection script which monitors in real 
time New format CDR from an MDR-2000; 
MDR-2000 requires a chip which is 
compatible with X11 Release 23

POLLCDR.SCR CDR data collection script for PollCat II/III 
buffer units

PARSESL1.SCR Functional script used by POLLCDR.SCR

POLLNEWX.SCR CDR data collection script for PollCat II/III 
buffer units; supports X11 Release 23

NEWCDRX.SCR Functional script used by POLLNEWX.SCR

AT1CDR.SCR CDR data collection script for AT1 buffer unit

AT2CDR.SCR CDR data collection script for AT2 buffer unit

PARSESL1.SCR Functional script used by AT1CDR.SCR and 
AT2CDR.SCR script files
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CDR data collection from SEB II
The following script files are used for data collection from the SEB II buff
unit.

CDR data collection from Sentinel 2000
The following script files are used for data collection from a Sentinel 200
buffer unit.

Call Tracking alarm scripts
The following script files are used for Call Tracking alarms. They will be 
automatically selected when you define the Call Tracking alarms.

AT1NEWX.SCR New format CDR data collection script for 
AT1 buffer unit; supports X11 Release 23

AT2NEWX.SCR New format CDR data collection script for 
AT2 buffer unit; supports X11 Release 23

NEWCDRX.SCR Functional script used by AT1NEWX.SCR 
and AT2NEWX.SCR script files

SEB.SCR CDR data collection script for SEB II buffer 
unit

PARSESL1.SCR Functional script used by SEB.SCR script file

SEBNEWX.SCR New format CDR data collection script for 
SEB II buffer unit; supports X11 Release 23

NEWCDRX.SCR Functional script used by SEBNEWX.SCR 
script file

SNLCDR.SCR CDR data collection script for Sentinel 2000 
buffer unit

SNLCDRX.SCR CDR data collection script for Sentinel 2000 
buffer unit; supports X11 Release 23

CMALARM.SCR Call Tracking alarm script

CMPAGER.SCR Call Tracking alarm pager script
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CDR data collection modem scripts
The following script files are supporting function scripts used by all CDR
data collection scripts for Call Tracking. The appropriate script will be 
automatically used when you select Hayes or Custom as the format for 
modem for CDR data collection from the OTM Site Configuration 
application.

If you enter custom modem information when setting up a site, then the 
custom modem script file will be updated with the appropriate parameter

HAYES.SCR Functional script used by all CDR data 
collection scripts in Call Tracking for 
connection with Hayes compatible modems

CUSTOM.SCR Functional script used by all CDR data 
collection scripts in Call Tracking for 
connection with customized modems (updated 
with correct parameters)
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Scri pt usa ge table
The following table lists the types of scripts which would be selected for 
different scenarios for Call Tracking. These represent the main scripts w
can be selected to suit a particular scenario. All other scripts will 
automatically selected depending on these script selections.

Table A-1
Script usage table

To Use

Perform real time CDR data collection from 
Meridian 1

SL1.SCR

Collect CDR from MDR-2000 buffer unit COLLECT.SCR

Collect CDR from PollCat II/III buffer units POLLCDR.SCR

Collect CDR from AT1 buffer unit AT1CDR.SCR

Collect CDR from AT2 buffer unit AT2CDR.SCR

Collect CDR from SEB II buffer unit SEB.SCR

Collect Traffic data from SEB II buffer unit SEBTRAF.SCR

Collect CDR from Sentinel 2000 buffer unit SNLCDR.SCR
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